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Avertissement

Le présent document est destiné à fournir les informations nécessaires à un utilisateur déjà habitué à se servir
d'une suite bureautique pour l'aider à démarrer avec OpenOffice.org.

Il ne prétend donc pas apporter un mode d'emploi détaillé sur l'ensemble des fonctionnalités de la suite.

En complément à cette présentation et pour approfondir les modes d'emploi qui ne sont pas détaillés ici, le
site français du projet OpenOffice.org comporte une rubrique Documentation qui propose :

• des guides d'installation et d'utilisation

• des How-to dont le nombre est en constante augmentation

• une foire aux questions régulièrement enrichie

• des outils, exemples modèles, etc...

Le site offre par ailleurs des listes de discussion (mailing lists) sont très actives. La liste USERS est destinée
à faciliter la résolution des problèmes rencontrés par les utilisateurs.

L'adresse du site OpenOffice.org en français est : http://fr.openoffice.org/

La navigation dans le site français se fait à partir des liens situés en milieu de page en haut et dans la colonne
de droite

La navigation vers le site anglais se fait à partir des liens de la colonne de gauche.
Voici quelques adresses complémentaires

Macros OpenOffice.org : http://www.starbasic.fr.st/

Dictionnaires : http://whiteboard.openoffice.org/lingucomponent/download_dictionary.html

StarOffice : http://www.staroffice.online.fr/consultation.html
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Introduction

Le présent document est destiné à servir de support pour l'utilisation de la suite OpenOffice.org dans le cadre
d'une organisation administrative.

Il s'adresse à des utilisateurs déjà habitués à une suite bureautique et ayant une connaissance suffisante des
principes de fonctionnement des outils bureautiques. Il ne détaille donc pas chacune des commandes avec
son mode d'emploi. Il est en effet présupposé que ces utilisateurs avertis seront capables à partir de la
comparaison des commandes de retrouver les modes d'emplois des fonctions de la suite OpenOffice.org.

On trouvera donc dans les chapitres ci-après une présentation des notions essentielles pour la :

• Rédaction de lettres aux clients ou usagers ;

• Rédaction de notes administratives avec plan automatique, styles et sommaire ;

• Rédaction de rapport même complexes avec tableaux, sommaires, utilisation de styles,
diagrammes, dessins, etc. ;

• Confection de feuilles de calcul simples comportant une seule feuille ;

• Confection de feuilles de calcul simples avec plusieurs feuilles et reports sur d'autres feuilles ou
d'autres fichiers ;

• Confection de tableau de calculs complexes du même niveau que les tableaux croisés dynamiques
de Excel.

• Réalisation de diaporamas, supports de présentations

La suite OpenOffice.org comprend des outils autres que le traitement de texte, le tableur, l'outil de
présentation, mais il est considéré que dans l'environnement administratif, l'utilisation de ces outils est
relativement rare et réservée à des agents spécialisés.

Des documentations spécifiques aux autres outils seront diffusées ou incluses dans le présent document
ultérieurement

Le parti pris dans le présent document n'est pas de détailler chacune des fonctionnalités mais, par des
tableaux comparatifs, de guider l'utilisateur habitué à la suite Microsoft Office à retrouver les commandes
équivalentes dans OpenOffice.org.

Ainsi, après une présentation générale de la suite OpenOffice.org, des tableaux comparatifs présenteront
l'équivalence entre les commandes des deux suites.

La signalétique suivante sera utilisée :

Les informations pour l'utilisation de OpenOffice.org sont signalées par cette icône d'information

Cette icône signale les difficultés ou problèmes liés à l'utilisation de OpenOffice.org

Néanmoins, quelques chapitres seront consacrés en fin de document à des fonctionnalités dont la conception
et le mode opératoire diffèrent sensiblement entre les deux suites.

Dans la suite du document, il est implicitement considéré que la suite OpenOffice.org est installée dans sa
version 1.0 ou 1.0.1 sur un poste de travail doté de Windows 98/2000/XP.
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1 - PRÉSENTATION GÉNÉRALE

La suite OpenOffice.org est une suite complète et intégrée comprenant un traitement de texte, un tableur, un
outil de présentation, un outil de dessin (vectoriel ou bmp), un éditeur de formules mathématique, un éditeur
HTML, ainsi que quelques outils complémentaires.

Elle est reconnue pour être la suite la plus compatible avec les outils Microsoft.

La présentation générale de l'application OpenOffice.org est très semblable à celle de la suite MS Office. Elle
présente toutefois quelques particularités qui modifient l'approche globale de l'outil.

1.1 - Une suite intégrée

La principale caractéristique de la suite OpenOffice.org est d'être une suite intégrée. Cela veut dire qu'au
contraire de la suite Microsoft dans laquelle les outils (traitement de texte, tableur, présentation) sont des
logiciels distincts que l'on peut démarrer séparément, le lancement de OpenOffice.org met à disposition tous
les outils ensemble.

Il suffit d'activer la commande Fichier>Nouveau pour constater que dans chaque composant de la suite, il est
possible d'accéder aux autres outils. Ainsi, une feuille de calcul peut être ouverte alors que l'on utilise le
traitement de texte.

L'avantage d'une suite intégrée réside justement dans cette intégration poussée des composants et dans les
facilités d'utilisation que cela procure.

En revanche, il est évident que le logiciel est plus complexe et volumineux et que son temps de démarrage
est plus long qu'avec des outils séparés.

OpenOffice.org utilise des extensions de fichiers propres à chacun des composants de la suite
:

Traitement de texte sxw W pour Writer

Tableur sxc C pour Calc

Présentation sxi I pour Impress

Dessin sxd D pour Draw

Mathématiques sxm M pour Math

Du fait de l'intégration de tous les outils dans une seule suite, le menu Fichier présente en
pied la liste des 4 derniers fichiers ouverts, quel que soit leur type (traitement de texte,
tableur, présentation, .doc, .xls, ...).

Il existe sur le site français OpenOffice.org une macro permettant l'affichage des 10 derniers
fichiers ouverts.

Pour la même raison, OpenOffice.org ne connaît qu'un seul répertoire par défaut pour les
modèles ou pour le Dossier de travail.

Pour séparer les types de modèles, créez des sous-répertoires spécialisés dans le répertoire par
défaut
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1.2 - Démarrage

Il existe plusieurs manières de démarrer OpenOffice.org

• par le menu Démarrer/Programme/OpenOffice.org donne accès au module choisi.

• par un double clic sur l'icône présente sur le bureau. Dans ce cas c'est le module Traitement de
texte qui est démarré par défaut.

• par un double clic sur l'icône de démarrage rapide

• par un clic avec le bouton droit sur l'icône de démarrage rapide

L'image ci après montre ces dispositifs sur le bureau de Windows.

1.3 - Le démarrage rapide

Le double clic sur l'icône de démarrage rapide ouvre la boîte de dialogue Modèles et Documents présentée
ci-dessous :
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Cette boîte de dialogue se décompose en trois parties :

• la partie gauche comporte les différentes catégories de document

• la partie centrale liste les documents de la catégorie

• la partie droite est une zone pré-visualisation

La catégorie « Nouveau document » donne la liste des types de document définis dans OpenOffice.org et
permet d'ouvrir un nouveau document du type choisi.

La catégorie « Mes Documents » donne accès au répertoire correspondant et affiche la liste des sous dossiers
et fichiers disponibles. On peut naviguer au moyen des icônes  et  affichées en haut de la fenêtre.

Les catégories « Modèles » et « Exemples » donnent accès aux modèles et exemples disponibles. En standard
OpenOffice.org ne dispose pas de modèles ou d'exemples.

Par ailleurs, un clic gauche sur l'icône de démarrage rapide ouvre le menu de démarrage rapide (voir image ci
après).'

Ce dispositif est l'équivalent, sur le bureau Windows, de la commande Fichier>Ouvrir de l'application. 

Si l'on choisit un des cinq premiers éléments de la liste, on démarre l'application et on ouvre un nouveau
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fichier du type choisi.

Le choix « Ouvrir un fichier » entraîne l'ouverture d'une boîte de dialogue de gestion de fichiers. Cette
fenêtre permet de naviguer dans les répertoires et de choisir le fichier recherché. Il est ainsi possible d'ouvrir
directement un fichier existant sans  avoir à démarrer OpenOffice.org au préalable.

L'outil de démarrage rapide entraîne une initialisation du poste de travail un peu plus long lors du
chargement de Windows.

De même, le premier démarrage de l'application est un peu plus long que le démarrage de Word ou Excel en
raison justement du chargement de tous les modules. 

Cependant, après le premier démarrage, l'application peut être fermée sans inconvénient. En effet les
modules étant chargés en mémoire, la réouverture de l'application sera quasiment instantanée.

De l'avis général, OpenOffice.org a un fonctionnement nominal sur tout micro-ordinateur
équipé d'un processeur Intel Pentium à 500 Mhz et de 128 Mo de mémoire.

Il fonctionne avec des temps de réponse qui deviennent de plus en plus importants sur les
configurations inférieures. Un fonctionnement convenable est encore possible sur des micro-
ordinateurs avec processeur P166 et 64 Mo de mémoire.

En dessous de cette configuration, le fonctionnement devient difficile et peut occasionner des
« plantages » réguliers.

1.4 - Gestion des fenêtres

L'ouverture de plusieurs documents ou textes dans OpenOffice.org entraîne la création d'autant de tâches
dans la barre de tâches de Windows. Les versions postérieures à MS Office 97 ont d'ailleurs le même
comportement.

Dans OpenOffice.org, la navigation entre plusieurs documents ouverts en même temps se fait soit par le
menu Fenêtre, soit par la barre des tâches de Windows ainsi que le montre l'image ci-dessous

Mais à la différence de MS Office, il n'est pas possible de fractionner et d'afficher dans OpenOffice.org
plusieurs documents dans plusieurs fenêtres à l'intérieur de la suite.

Les outils de fractionnement et de re-dimensionnement des fenêtres de MS Office sont remplacés par
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l'utilisation des fonctions de l'environnement graphique de réduction/agrandissement et par les fonctions de
positionnement et de dimensionnement des fenêtres au moyen de la souris.

De ce fait, les menus fenêtres de chacun des éléments de la suite ne présentent aucune des commandes
présentes dans la suite MS Office.

Le glisser/déposer entre les deux fenêtres permet de recopier des éléments d'un document dans l'autre.

L'image ci dessous démontre ces possibilités :

Une méthode simple pour glisser/déposer entre documents

Le glisser déposer peut aussi se faire sans que les deux fenêtres soient ouvertes. Pour cela, les
deux documents étant ouverts dans la barre des tâches, le document source étant affiché, il
faut : 

• sélectionner dans le premier document la partie de texte, par exemple, que l'on veut
copier dans l'autre document,

• faire glisser la sélection avec la souris vers le bouton de l'autre document dans la
barre des tâches,

• attendre quelques millisecondes, le document cible s'ouvre,

• positionner le curseur à l'endroit où l'on veut placer la sélection et relâcher le
bouton de la souris

Cela permet de garder tout l'espace de l'écran pour travailler.

Le Navigateur permet de travailler de manière très pratique entre plusieurs documents.

Ces fonctionnalités sont détaillées au chapitre sur le Navigateur
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1.5 - Fermeture de l'application

Dans la suite OpenOffice.org, la fermeture de la dernière fenêtre entraîne la fermeture de l'application, ce qui
peut être gênant si l'on veut ouvrir un fichier. Il est en effet nécessaire de redémarrer l'application.

Devant ce comportement la première attitude est de penser qu'il s'agit d'une mauvaise conception de
l'application. 

En effet, nous sommes habitués à ce que dans les applications telles que Word ou Excel, l'application reste
ouverte même si le dernier fichier est fermé. 

Cela est dû au fait que ce sont des applications MDI (Multiple Document Interface). Elles se caractérisent par
une fenêtre principale à l'intérieur de laquelle apparaissent des fenêtres filles (les documents). L'ouverture et
la fermeture de ces deux types de fenêtres sont gérées différemment. Ce comportement avait été institué pour
pallier les problèmes de lenteur de démarrage au début des applications bureautiques.

Ce comportement de OpenOffice.org. est corrigé par la possibilité d'ouvrir un fichier depuis
le bureau de Windows à l'aide d'un clic sur le bouton droit de la souris (voir §1.2 Démarrage).

En fait depuis le bureau de Windows, on dispose de la commande Fichier>Ouvrir, ce qui
compense largement la fermeture de l'application.

La version 1.1 de OpenOffice.org corrige définitivement cet inconvénient en gardant
l'application ouverte après la fermeture du dernier fichier.

Ce comportement devient totalement similaire à celui de la suite Ms Office
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2 - LE BUREAU OPENOFFICE.ORG

Le bureau de chacun des modules de OpenOffice.org. 1.0 est d'une présentation générale très similaire. On
trouvera ci dessous une description succincte des principes d'ergonomie appliqués.

2.1 - Description

2.1.1 - L'interface

L'interface du bureau de OpenOffice.org comporte 5 barres d'outils visibles :

• La barre de menu qui liste les commandes selon une présentation par menu

• La barre de fonctions qui comporte les icônes d'exécution des actions les plus communes (ouvrir,
fermer, enregistrer, couper, copier, coller, imprimer, ) ;

• La barre d'objets avec les icônes de formatage (caractères, alignement, couleurs, ...) propres au
module utilisé ;

• La barre d'instruments avec les outils spécifiques du module affiché pour insérer des champs, des
données, des formes, des images et tout type d'objets ;

• La barre d'état des documents qui affiche les informations sur la page courante : modèle courant, %
de zoom, mode insert ou refrappe, mode de sélection, mode hyperlien.

L'image ci après établie sur le traitement de texte présente ces différentes notions.
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2.1.2 - Les menus contextuels

De plus, en raison de l'intégration des modules, les menus ainsi que les barres d'objets et d'instruments sont
contextuels en fonction du type d'action en cours dans le document. 

En particulier, la barre d'objets sera totalement différente selon que le curseur se situe dans du texte, dans un
tableau, sur une image, sur un graphique, sur un dessin. Ainsi à partir d'une présentation qui paraît
homogène, des fonctionnalités apparaissent ou disparaissent.

De même les menus seront différents selon que le curseur est placé dans du texte, un tableau, sur une image,
des puces, un objet,...

En cas de doute sur l'action engagée par le clic sur une icône, le survol prolongé de cette icône par le curseur
entraîne l'affichage d'une bulle décrivant la fonction sous-jascente. 

L'ensemble des actions présentées au travers de ces menus sont aussi disponibles dans des menus
contextuels.

Pour connaître la liste des actions disponibles sur un objet quelconque (tableau, image, graphique, mot), un
clic sur le bouton droit de la souris déclenche l'apparition d'un menu adapté à la situation.

Voici l'exemple d'un menu contextuel affiché par un clic sur le bouton droit de la souris, le curseur étant
placé dans le tableau

Lorsque le curseur se trouve dans la position où plusieurs barres d'objets sont disponibles, un
bouton apparaît à l'extrémité droite la barre d'objets

Sans changer l'emplacement du curseur il est possible de passer d'une barre d'objets à une
autre selon l'une des deux méthodes suivantes :

• Cliquer sur la dernière icône du côté droit de la barre d'objets.

• Ouvrir le menu contextuel de la barre d'objets (clic droit de la souris sur la dernière) .
Effectuez votre choix dans la liste des barres d'objets disponibles qui s'affiche.
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2.1.3 - Les icônes déployables

En observant les différentes barres, on constate que certaines icônes comportent dans leur coin haut droit, un
petit triangle vert.

Le présence de ce triangle vert indique la présence de choix multiples sous cette icône. Ces choix se
déploient dans une barre complémentaire d'actions lors d'un clic prolongé sur l'icône.

On peut choisir l'action voulue dans le choix présenté.

De plus, certaines barres d'actions ainsi déployées comportent une barre de titre dont la présence indique que
ces barres sont détachables. On peut les déplacer par glisser /déposer en pointant la barre de titre avec le
bouton droit de la souris.

L'image ci-dessous montre un exemple de ces déploiements.
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2.1.4 - Les fenêtres ancrables

Certaines fenêtres de OpenOffice.org sont des fenêtres ancrables, telles que le Styliste, le Navigateur ou la
Gallery. 

L'utilisation du Styliste et du Navigateur est  décrite dans les chapitres suivants.

Ces fenêtres, peuvent être déplacées, modifiées en taille ou ancrées à une marge. Sur chaque bordure, vous
pouvez ancrer plusieurs fenêtres en les empilant ou en les juxtaposant ; vous pouvez ensuite modifier la part
relative de la fenêtre en décalant les lignes de délimitation à l'aide de la souris.

Pour désactiver puis réactiver l'ancrage, double-cliquez sur la fenêtre en maintenant la touche (Ctrl)
enfoncée. Double-cliquez de cette manière sur une zone vierge de la fenêtre ; dans le Styliste, double-cliquez
sur une zone grisée de la fenêtre, par exemple, à côté des icônes.

Pour le Navigateur, cette présentation ancrée est tout à fait comparable au mode Affichage>Lecture à l'écran
de MS Word. Toutefois, ainsi que vous le verrez au chapitre qui lui est consacré, le Navigateur est un outil
beaucoup plus performant que le mode lecture à l'écran.

L'affichage ou la fermeture de la fenêtre ancrée s'obtient en cliquant sur la flèche d'affichage .

La fenêtre peut être rendue flottante ou ancrée en cliquant sur le bouton . La fenêtre est flottante quand elle
se superpose au document. Elle est ancrée quand le document est juxtaposé à la fenêtre et apparaît donc dans
sa totalité.

Voici le type de présentation obtenue avec le navigateur en fenêtre ancrée.
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2.2 - Personnalisation des barres

Chaque barre peut être personnalisée soit au moyen du menu Outils>Adaptation soit par un clic droit dans la
partie vide de la barre concernée.

Dans ce dernier cas, le menu contextuel fait apparaître, en première partie de liste, les barres affichées 

En seconde partie du menu contextuel apparaissent les choix :

• « Boutons visibles » qui permet de fixer la liste de boutons affichés. 

• « Adaptation » qui renvoie à la boîte de dialogue du menu Outils Adaptation

• « Personnaliser » qui affiche directement le choix Personnaliser de la boite de dialogue Adaptation

Le choix boutons visibles permet d'afficher la liste prédéfinie des icônes qui peuvent être affichées. Un
simple clic du bouton gauche sur la ligne correspondante entraîne ou supprime l'affichage du bouton dans la
barre.

Il est possible d'ajouter des commandes à cette liste par le choix Personnaliser. 

Pour cela, dans la boite de dialogue Personnalisation des barres d'outils,

•  sélectionner une catégorie et une fonction. 

• en partie haute de la boîte de dialogue, le bouton correspondant est activé ;

• déposer ce bouton par glisser déposer sur l'emplacement voulu de la barre d'outils. 

On remarquera que les boutons peuvent être des textes au lieu d'icône.

Voici un exemple de personnalisation de la barre d'instruments

Page 17/84 Version 1.0.1 du 24/06/2003



2.3 - Conseils et recommandations

L'outil de personnalisation est très riche et il est tentant de modifier la présentation des barres d'outils pour y
ajouter des icônes supplémentaires.

A l'usage, il apparaît rapidement que l'on ne peut mémoriser la signification de toutes les icônes surtout
celles qui ne sont pas couramment utilisées.

Il faut donc éviter d'en ajouter à celles qui existent.

La bonne méthode est de penser à utiliser le clic sur le bouton droit de la souris. Cela permet d'afficher les
choix disponibles dans le contexte ou l'on se trouve et s'avère très efficace.

Néanmoins, quelques personnalisations sont très intéressantes.

Afficher les menus inactifs

Dans l'installation standard de OpenOffice.org, seules sont présentes dans la barre de menu, les actions
opérantes dans le contexte. 

Ainsi par exemple, couper et copier ne sont affichés dans le menu déroulant que si un objet a été sélectionné.

Il est possible dans OpenOffice.org d'obtenir l'affichage de toutes les options, celles qui sont inopérantes
apparaissent en grisé.

Pour cela il faut modifier les options standard :

Menu Outils> Options> OpenOffice.org> Affichage> Entrées de menus inactives

Sélectionner tableau

Curieusement, il n'existe pas de commande dans le menu pour sélectionner un tableau entier dans l'outil de
traitement de texte. Il peut donc être très utile de placer l'icône de cette commande dans la barre d'objets de
tableau.

Pour cela, placer le curseur dans un tableau, ce qui a pour conséquence d'afficher la barre d'objets de tableau.

Par un clic droit dans la zone libre de la barre d'objets, afficher le menu contextuel. Choisir l'option
« Boutons visibles ». Activer « Sélectionner tableau ». L'icône apparaît dans la barre d'objet de tableau. 

Bien entendu, cette icône  ne sera visible que si le curseur est placé dans un tableau

Répéter la dernière commande

La répétition de la dernière commande s'obtient par le menu Édition>Répéter

Il n'existe pas de raccourci clavier pour exécuter rapidement cette répétition sans passer par les menus. 

Il serait possible d'affecter à un raccourci clavier (Ctrl Y) une action pour retrouver les modes opératoires de
MS Office. Mais il se trouve que ce raccourci est déjà utilisé pour déclencher le gestionnaire de style ou
Styliste.

Une solution réside donc dans l'affichage de l'icône Répéter dans la barre de fonctions 

Pour cela, se placer dans la barre de fonctions. Avec le clic droit, activer le menu contextuel. Choisir l'option
« Personnaliser »

Dans la boîte de dialogue, dans la rubrique catégorie choisir « Édition »

Dans la liste placée au-dessus apparaît l'icône Répéter:Insérer. La transporter à l'endroit choisi de la barre de
fonction par glisser/déposer (sélection avec le bouton gauche de la souris et déplacer en gardant le bouton
appuyé)
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Rafraîchir l'écran

Dans certaines configurations, et en particulier lorsque l'on crée ou modifie des tableaux, on constate que
certaines lignes ou caractères ne sont plus ou mal affichés. Cela est dû à un défaut de rafraîchissement de
l'écran par Windows.

Deux méthodes peuvent être employées pour forcer Windows à rafraîchir l'écran :

• Monter ou descendre l'ascenseur, pour masquer et ré-afficher les éléments mal affichés

• Faire Ctrl+Maj+R.
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3 - LES COMMANDES COURANTES

Dans ce chapitre, sont présentées les commandes courantes des deux suites.

Il s'agit des commandes communes aux différentes composantes des deux suites pour la manipulation des
fichiers, l'affichage, le copier coller, l'orthographe, etc .

Ces commandes étant utilisées dans tous les outils, elles ne seront pas répétées dans les parties consacrées à
l'étude comparative de chacune des fonctions des suites.

Sauf variation mineure et occasionnelle, le principe retenu est de prendre appui sur les menus des outils de
MS Office et de décliner les menus correspondants de OpenOffice.Org.

MS Office 97 OpenOffice.org 1.0
Commande menu Clavier Menu Clavier

Fichier Nouveau
Ouvrir
Fermer
Enregistrer
Enregistrer sous
Mise en Page
Aperçu avant Impression

(propriétés de Fichier Imprimer)
Fichier Imprimer

Ctrl N
Ctrl O

Ctrl S

Ctrl P

Fichier Nouveau
Ouvrir
Fermer
Enregistrer
Enregistrer sous

Format Page
Fichier Aperçu avant impression

Configuration de l'impr.
Imprimer

Ctrl N
Ctrl O

Ctrl S

Ctrl P

Édition Annuler
Répéter
Couper
Copier
Coller
Rechercher
Remplacer

Édition Atteindre

Ctrl Z
Ctrl Y
Ctrl X
Ctrl C
Ctrl V
Ctrl F
Ctrl H
Ctrl B

Édition Annuler
Répéter
Couper
Copier
Coller

(1) Rechercher et remplacer

Édition Navigateur

Ctrl Z

Ctrl X
Ctrl C
Ctrl V
Ctrl F

F5

Affichage Page
Zoom
Plein écran

Affichage Zoom (Page)
Zoom

Plein écran Ctrl Maj J
Outil Orthographe

Correction automatique
Outil Macros

Personnaliser
Options

Outil Orthographe (2)
Vérification automatique
Macros
Adaptation
Options

Fenêtre Nouvelle Fenêtre Fenêtre Nouvelle Fenêtre (3)
(1) le remplacement des caractères génériques n'est pas opérationnel dans la version actuelle de
OpenOffice.org (marques de paragraphes, retour chariot, tabulations).

(2) OpenOffice.org n'a pas de correcteur grammatical.

(3) Dans la suite OpenOffice.org, l'ouverture d'une fenêtre s'entend comme une nouvelle instance de
document et donc entraîne l'apparition d'une nouvelle tâche dans la barre de tâches de Windows ; le partage
d'écran, le dimensionnement se règle donc au moyen des outils de Windows et non par des commandes
internes à la suite. (voir chapitre 1-3).
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La fonction de mise en page

Dans OpenOffice.org, la mise en page des documents ne répond pas à la même logique que
dans MS Office. 

Dans MS Office, la mise en page s'applique au document ou à une section ou à partir d'un
certain point.

En revanche, dans OpenOffice.org la mise en page est attachée au style de page. A chaque
page est attaché un style de page (par défaut Standard). C'est d'ailleurs ce que l'on constate
dans l'intitulé de la boîte de dialogue de la commande Format>Page.

La conséquence de cette orientation, c'est que la modification du style de page Standard (par
exemple) par la commande Format>Page va s'appliquer à toutes les pages de styles Standard. 

Plus généralement, votre mise en page sera modifiée pour toutes les pages de même style que
celle en cours, chaque fois que vous interviendrez dans Format>Page 

Profitez de la souplesse de gestion des formats de page apportée par OpenOffice.org.

Créez un style de page approprié pour la mise en page voulue (portrait, paysage, hauteur,
marges, ...) et appliquez-les en tant que de besoin.

Le chapitre sur les styles vous précisera la marche à suivre.

La vérification automatique de l'orthographe

La vérification automatique de l'orthographe s'obtient en sélectionnant la commande

Outils>Orthographe>Vérification automatique ou en activant l'icône de la barre
d'instruments. Les mots erronés sont alors soulignés en rouge. 

Un clic droit de la souris sur le mot souligné vous propose la liste de mots de remplacement
du dictionnaire dans le menu contextuel. Sélectionnez une suggestion de correction pour
remplacer le mot erroné.

Le correcteur orthographique détecte les mots absents du dictionnaire mais ne sait pas
proposer une suggestion de correction pour les mots comportant plus d'une faute.

Enregistrement après impression

OpenOffice.org demande systématiquement d'enregistrer un document après son impression
même s'il n'a pas été modifié. 

Pour supprimer cette option,

• Outils>Options>OpenOffice.org>Général

• dans la Rubrique Statut du document, décocher le case Impression : statut du doc....
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4 - LE TRAITEMENT DE TEXTE

Les tableaux ci-après recensent une grande partie des fonctionnalités spécifiques aux outils de traitement de
texte de chaque suite et les commandes correspondantes de menu ou de raccourci clavier.

Sont détaillées dans le premier tableau les commandes courantes utilisées par un agent dans l'exercice de
fonctions de rédaction de lettres, textes courts ou note de présentation

Les tableaux suivants détaillent les fonctionnalités complètes pour la réalisation de tableaux et de
publipostage.

4.1 - Commandes pour la réalisation de textes simples (lettres, notes,
fiches)

Le tableau ci-après détaille les commandes comparées des deux suites pour la réalisation de textes simples.

MS Word 97 OpenOffice.org 1.0 Texte
Menu Clavier Menu Clavier

Édition Sélectionner tout Ctrl A Édition Sélectionner tout Ctrl A

Affichage Normal
Lecture à l'écran
Explorateur de documents

Affichage Mise en page en ligne
Édition Navigateur F5

Insertion Saut
Date et heure
Numéro de page
Champ
Caractères spéciaux
Note

/Note de bas de page
Note

/Note de fin de page
En tête
Pied de page

Insertion Saut manuel
Champ/Date/heure
Champ/Numéro de page
Champ/Autres
Caractères spéciaux
Note de bas de Page

/Note de bas de page
Note de bas de page

/Note de fin
En tête
Pied de page

Format Police
Paragraphes

Format Caractères
Paragraphes

La mise en forme de caractères

La commande Format>Caractères affiche une boîte de dialogue comportant plusieurs onglets.

L'onglet Police permet de choisir la police de caractères, d'en régler le style, la taille, et la
couleur.

Pour appliquer, les « attributs » de MS Word, il faut passer par l'onglet Effets de caractères. 
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La gestion des en-têtes et des pieds de page

Dans OpenOffice.org les en-têtes et pieds de page sont liés au style de page. Leur gestion est
donc sensiblement différente que dans MS Word. Pour l'exemple, nous prendrons les pieds
de page.

La commande Insertion>Pied de page ne se présente pas du tout comme dans MS Word.
Vous voyez en effet que sur le menu s'affiche la liste des styles de page utilisés dans votre
document. 

Vous pouvez activer ou désactiver le pied de page en cochant ou décochant le style de page. 

Pour plus de paramétrage il vous faudra passer par la procédure de modification des styles de
pages. Cette procédure est décrite dans le chapitre consacré aux styles dans OpenOffice.org

Vous devrez insérez les informations que vous voulez voir répéter sur les pages de votre
document, dans chaque pied de page correspondant à un style de page différent 

4.1.1 - Insertion d'images ou d'objets

A ces commandes peuvent être ajoutées celles nécessaires à l'insertion d'images et d'objets dans un texte
simple pour l'incorporation de logos ou d'images.

MS Word 97 OpenOffice1.0 Texte
Insertion Images

Images de la bibliothèque
Insertion Images

A partir du fichier
Insertion Objet

Outils Gallery

Insertion Images
A partir d'un fichier

Insertion Objet

Obtenir une image ou objet stable

Quand on insère un objet, un graphique ou une image, il est souvent difficile de bien les
positionner sur la page sans que leur position soit changée par une modification ultérieure du
document

Voici l'une des manières qui permet d'obtenir une très bonne stabilité :

• Ancrez l'image ou l'objet comme caractère (menu contextuel sur l'image). Ainsi il
est considéré comme un caractère de paragraphe, ce qui est très stable,

• Créez un style de paragraphe qui respecte la mise en page souhaitée pour vos
images ou objets. Surtout, n'oubliez pas les écarts avant ou après qui feront que
votre image ne chevauchera jamais les textes adjacents,

• Appliquez ce style, en faisant bien attention de sélectionner le paragraphe et non
l'image ou l'objet.
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Créer une image composite 

Il peut être utile d'ajouter des informations ou commentaires à une image ou un graphique, au
moyen de bulle de texte par exemple.

Dans ce cas, pour obtenir une image stable, procédez de la manière suivante :

• Composez votre image avec la barre de dessin dans le traitement de texte ;

• Copiez tous ces éléments dans l'outil de dessin ;

• Groupez tous ces éléments 

• Exportez l'image au format JPEG par la commande Fichier>Exporter et insérez
l'image obtenue dans le traitement de texte

On peut aussi après avoir groupé les éléments, les incorporer au texte par copier/coller. Dans
ce cas, le problème est que l'on n'insère plus une image mais un « support de travail » qui ne
peut être reconnu comme image et donc servir de référence dans le navigateur.

Il semble aussi que dans ce cas la stabilité du document ne soit pas certaine.

4.2 - Commandes pour la création de tableaux

Un tableau peut être créé en utilisant les fonctionnalités suivantes :

• la commande Insertion>Tableau

• la combinaison de touches Ctrl+F12

• l'icône déployable Insérer, située en tête de la barre d'instruments

Chacune de ces commandes appelle l'affichage de la boîte de dialogue ci-après

Cette boîte de dialogue vous permet de configurer votre tableau selon votre convenance.

Le bouton Autoformat met à votre disposition des modèles de tableaux prédéfinis.

Il peut être très intéressant de nommer le tableau d'un nom significatif. En effet, ce nom apparaîtra dans la
liste des tableaux affichés par le Navigateur. Si vous rédigez un texte comportant plusieurs tableaux, il vous
sera ainsi facile de les reconnaître et de les atteindre directement. 

Ces fonctionnalités du Navigateur sont expliquées au chapitre spécifique.

Le tableau ci-après récapitule les principales commandes utilisables. Certaines de ces fonctions sont
disponibles par le menu contextuel.
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MS Word 97 OpenOffice.org 1.0Texte
Tableau Insérer un tableau

Sélectionner le tableau
Trier 
Formule
Scinder le tableau
Convertir tableau en texte
Format automatique de tableau

Insérer Tableau
(icône de la barre d'objets)
Outil Trier
Barre de calcul (touche F2)
Format Scinder le tableau

Texte<->Tableau
Autoformat

Tableau Insérer des lignes
Supprimer des lignes
Sélectionner la ligne
Uniformiser la hauteur des lignes

Format Ligne/Insérer
Ligne/Supprimer
Ligne/Sélectionner
Ligne/Hauteur

Tableau Insérer des colonnes
Supprimer des colonnes
Sélectionner la colonne
Uniformiser la largeur des colonnes

Format Colonne/Insérer
Colonne /Supprimer
Colonne /Sélectionner
Colonnes/Largeur optimale

Tableau Fusionner les cellules
Fractionner les cellules

Format Cellule/Fusionner
Cellule/Fractionner

Gérer l'écart entre la bordure des cellules et le texte

Dans MS Word l'écart entre les bordures de cellules et le contenu est géré au moyen de la
commande Format>Paragraphe. 

Dans OpenOffice.org cette commande est inopérante pour les bordures hautes et basses. En
revanche, on peut contrôler les écarts à droite et à gauche par la commande
Format>Paragraphe, ce qui paraît normal car l'alignement des paragraphes peut varier dans
une même cellule.

Pour gérer l'écart entre la bordure et le contenu, il faut utiliser la commande Format>Tableau
Onglet Bordure.

La rubrique « Écart avec le contenu » permet de faire varier cet écart soit de manière
synchronisée, soit indépendamment pour le haut, le bas, droite ou gauche.

Pour obtenir des écarts différents selon les cellules, lignes, colonnes sélectionner d'abord les
cellules, lignes, colonnes.

Attention, si vous devez modifier un élément s'appliquant à l'ensemble du tableau (trait de
bordure par exemple), c'est l'écart standard qui s'appliquera à toutes les cellules. Les écarts
précédemment spécifiés seront tous annulés.

Les écarts entre bordure et contenu sont perdus lors de l'enregistrement au format MS Word.
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Modifier la largeur de colonnes

La largeur de colonnes se modifie aisément avec la souris.

Cependant, dans les tableaux complexes comportant des cellules fusionnées ou scindées, il
arrive que se produisent des blocages.

Dans ce cas, l'onglet Colonnes de la boîte de dialogue Tableau permet de gérer très
facilement les largeurs de colonnes (Accès par le menu Format Tableau ou menu contextuel
Tableau)

Insérer un paragraphe en début de page devant un tableau

Insertion d'un texte au début d'un document texte, devant un tableau inséré ou directement
après un saut de page fixe :

1. Placez le curseur dans la première cellule du tableau au tout début du contenu de
cette cellule.

2. Appuyez sur la touche Entrée.

Supprimer un tableau

Il n'existe pas de commande pour supprimer un tableau.

Pour supprimer un tableau, il faut d'abord le sélectionner au moyen de l'icône ou en déplaçant
le curseur sur les cellules, lignes, colonnes .

Puis, il faut utiliser la commande Format>Ligne ou Format>Colonne Supprimer ou bien

l'icône correspondante  ou .

Calculer dans un  tableau

Il est très facile d'introduire des formules de calcul dans un tableau de traitement de texte. Un
tableau est considéré comme dans le tableur comme un ensemble de cellules numérotées, qui
sont donc adressables dans les mêmes conditions. De la même manière que dans le tableur,
l'inclusion des noms de cellules dans les formules est obtenu dynamiquement en portant le
curseur dans la cellule.

Pour cela, après avoir placé le curseur dans une cellule, appuyer sur la touche F2 ou saisir le
signe =, une barre de calcul apparaît à la place de la barre d'objets. Un clic sur le signe de
la barre d'objets ouvre la barre de calcul avec la fonction « somme » présélectionnée.

La première icône  de la barre de calcul donne accès à une liste de fonctions de calcul.

Pour modifier une formule, se positionner dans une cellule et appuyez sur F2. Modifier la
formule dans la barre de calcul.

Il est possible d'effectuer des calculs entre plusieurs tableaux d'un même texte.
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4.3 - Les styles

Dès lors que l'on rédige un rapport ou des documents comportant des mises en page compliquées, l'utilisation
de commandes de styles s'impose. 

Toutefois dans OpenOffice.org, il est recommandé d'utiliser les commandes de styles et d'éviter les
surcharges des styles prédéfinis au moyen des commandes mises en forme (caractères, paragraphes, ...), en
particulier si le document doit être convertit dans un autre format.

Ci après le tableau comparatif des divers menus à utiliser. 

MS Word 97 OpenOffice.org 1.0 Texte
Format Style/Nouveau

Style/Modifier
Style/Supprimer
Style/Organiser

Format Style/Catalogue/Nouveau
Style/Catalogue/Modifier
Style/Catalogue/Supprimer
Style/Catalogue/Gérer

Dans OpenOffice.org 1.0, les fonctions de styles sont disponibles sur les caractères, les paragraphes, les
pages, la numérotation, les cadres.

Plusieurs commandes sont disponibles pour appliquer un style prédéfini :

• le menu Format/Style/Catalogue, sélectionner la catégorie de style, puis double clic sur le style
choisi ;

• dans la liste des derniers styles utilisés, double clic sur le style choisi ;

• activation du Styliste par la commande Format>Styliste, l'icône ou la touche F11 puis double
clic sur le style choisi ;

• le mode « Remplir tout »ou Verseuse disponible dans le Styliste qui recopie le style
sélectionné

L'image ci-après présente les différents modes d'accès aux fonctions de styles :

Page 27/84 Version 1.0.1 du 24/06/2003

Styles 
dernièreme
nt utilisés

Styliste

Remplir 
tout ou 
Verseus

e

Icône 
d'activation 
du  styliste



Le mode d'emploi du Styliste qui est un outil commun à toutes les composantes de la suite OpenOffice.org
est décrit dans le chapitre 7.3 

Appliquer les styles avec la Verseuse 

Le traitement de texte MS Word dispose d'un outil dénommé « Pinceau » permettant de
recopier des attributs de mise en forme de texte.

Dans OpenOffice.org, c'est la Verseuse qui se charge de cette fonction.

Sélectionner un style (de page, de caractère, de paragraphe, ...) dans le Styliste. Cliquer sur la

Verseuse . 

Cliquer sur les éléments auxquels le style doit être appliqué. Répéter l'opération autant de fois
que souhaité. Cliquer sur la verseuse pour annuler son action.

La Verseuse ne recopie que des styles déjà définis. OpenOffice.org ne fait pas de
barbouillages.

Conçu pour une utilisation privilégiée des styles, OpenOffice.org fonctionne mieux si l'on ne
surcharge pas les styles existants par les fonctions de Format Paragraphe ou Caractères.

4.3.1 - Créer ou modifier un style

On peut créer un style ou modifier un style existant par la commande menu Format>Style>Catalogue bouton
Nouveau ou Modifier.

Toutefois, il est souvent plus simple d'utiliser le Styliste. Dans ce cas, le menu contextuel affiché par un clic
sur le bouton droit de la souris présente les choix Nouveau, Modifier, Supprimer.

Quel que soit le mode d'accès, la même boîte de dialogue s'affiche correspondant au type de style que vous
souhaitez créez ou modifier

Pour créer un nouveau style, procéder de la manière suivante :

• Dans la boîte de dialogue de la commande Format>Styles>Catalogue ou dans le Styliste,
sélectionner le type de style à créer (paragraphe, caractères, page, ...) et choisir Nouveau

• Dans l'onglet Gérer, donner un nom au style

• Si besoin est, positionner les styles de suite, la liaison à un autre style, le classement en catégorie

Les liaisons entre styles

Pour les styles de paragraphe et de caractères OpenOffice.org propose de lier les nouveaux
styles avec un style existant.

Le nouveau style hérite de fait de toutes les caractéristiques du style lié, qui seront
remplacées pour certaines par celles qui seront spécifiques aux nouveaux styles.

Les caractéristiques non modifiées sont donc directement liées au style de base

En conséquence, une modification des caractéristiques du style de base pourra être répercutée
de proche en proche dans les styles héritiers.
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Classement des styles de paragraphe

Lorsque l'on crée un nouveau style de paragraphes, OpenOffice.org propose de le classer
dans une catégorie par défaut.

Il peut être intéressant de changer ce classement notamment si vous désirez que tous vos
styles soient classés dans la catégorie Styles personnalisés. Ce classement peut être très
pratique pour la mise en oeuvre de vos styles avec le styliste.

Pour cela, lors de la création ou de la modification, passez par l'onglet Gérer et choisissez
votre catégorie. 

Supprimer des styles 

Le menu contextuel du Styliste ou la commande Format>Styles>Catalogue affichent un
choix Supprimer.

Notez que ce choix n'est actif que pour les styles que vous avez créés. Il est impossible de
supprimer les styles proposés par OpenOffice.org en standard.

Lorsque l'on veut supprimer un style, la suite indique si le style est utilisé avant toute
suppression.

Pour rechercher les emplacements où un style est utilisé, employez la commande
Édition>Rechercher et Remplacer qui comporte une option de recherche par les styles 

4.3.2 - Les styles de page

Pour gérer la mise en page des documents, OpenOffice.org introduit la notion de style de page. Cette notion
se substitue à celle de section dans MS Word.

Elle permet une gestion beaucoup plus fine de la mise en page puisque l'on peut créer autant de styles de
page que de besoin (Première page, page de sommaire, paysage, etc).

Outre les paramètres classiques de taille et de marge, le style de page permet de définir la présence d'en-tête
et de pied de page, de colonnes, de bordure, etc.

Voici la boîte dialogue permettant de régler ces paramètres
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Le format de page Standard

La commande Format>Page agit directement sur le style de page courant. 

Une modification par cette commande sera répercutée sur toutes les pages de même style

Si vous voulez utiliser votre propre style de page, créez un style « Page courante » qui vous
soit propre plutôt que de surcharger le style « standard »

Insérer une page au format paysage

Par l'une des méthodes décrites en début de § 5.1.3., créer un style de page « Paysage ». Ne
pas oublier de mettre en style de suite le style utilisé pour les pages normales

Dans l'onglet « Page » de la boîte de dialogue « Style de Page » choisir orientation
« Paysage »

Pour insérer une page de style « Paysage », placer le curseur en fin de page, par la commande
Insertion>Saut manuel>Saut de page, dans la liste déroulante « Style » choisir Paysage 

Il est également possible de changer le style d'une page. Pour cela, placer le curseur dans la
page et appliquer le style voulu, soit par le Styliste, soit par la commande
Format>Style>Catalogue.

Un document avec une première page différente

OpenOffice.org propose un style de page « Première Page ». Dans l'onglet Gérer on voit que
le style de suite est « Standard ». Le modifier si l'on a créé son propre style de page courante.

Modifier le style « Première page » en activant l'en-tête de page (Onglet En-tête). Modifier
éventuellement les paramètres d'écart et de position.

Sur le document vierge appliquer le style de page « Première page »

• Saisir le texte, insérer un logo ou une image dans l'en-tête par exemple 

• En fin de texte, passer à la page suivante soit par 'Ctrl+Entrée' soit par
Insertion>Saut manuel>Saut de page

• la seconde page prend le style « standard » donc sans logo ni en-tête de page

On peut bien entendu faire la même opération pour les pieds de page.
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Commencer une numérotation de page en page 2

Il est parfois intéressant de ne commencer la numérotation des pages que sur la page 2. Pour
cela :

• Appliquer à la première page, le style « Première page » sans insérer de numéro de
page (il peut y avoir ou non un pied de page)

• Dans le style de page « Standard », activer le pied de page afin de pouvoir y insérer
la numérotation 

• dans le pied de page de la page 2, insérer le champ « numéro de page »

La conversion des en-têtes et pieds de page

La gestion des en-têtes et des pieds de page par le moyen des styles de page est très efficace
sur le plan de la conception des documents. Elle a cependant des effets pervers sur la
portabilité des documents vers MS Word, dans l'état actuel des outils de conversion.

En effet, dans MS Word les en-têtes et pieds de page sont gérés au niveau de la section.

Ces deux méthodes étant assez différentes, les conversions successives d'un traitement de
texte à l'autre entraînent rapidement des confusions dans la gestion des en-têtes et pieds de
page.

4.4 - Plan et Numérotation

4.4.1 - Plan et titre

OpenOffice.org propose nativement des styles de paragraphes correspondant à 10 niveaux de titres (Titre 1 à
Titre 10) ainsi qu'un niveau de titre supérieur (Titre).

Les styles de paragraphes Titre 1 à Titre 10 sont ceux qui seront utilisés pour l'insertion d'un sommaire
automatique. Ce sont aussi ceux qui servent à la constitution du plan du Navigateur. Et encore à la création
automatique d'un document maître.

Plutôt que de créer des styles de titre adaptés au besoin d'une charte graphique particulière, il est
recommandé de modifier les styles existants, ce qui évitera de changer le paramétrage de base de la suite.

Le Titre 1 sera attribué au niveau de plan le plus élevé, le Titre 10 au niveau le plus faible. Il est évident que
l'on peut n'utiliser que les niveaux de plan dont on a besoin.

Pour donner la forme désirée au titre d'un paragraphe, section, chapitre, il suffit d'attribuer au paragraphe le
style de niveau correspondant à sa situation dans le plan.

Seuls les niveaux Titre 1 à Titre 10 sont, en standard, pris en considération pour
l'établissement du plan dans le sommaire et le Navigateur.

Le niveau Titre n'est pas repris dans le Navigateur.

Il peut être ajouté dans le sommaire automatique. (Voir § 4.5 ci après)
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4.4.2 - Numérotation

MS Word 97 OpenOffice.org 1.0 Texte
Format Puces et numéros

Hiérarchisation
Outils Numérotation des chapitres

Numérotation
L'utilisation de la commande Outils>Numérotation des chapitres appelle l'affichage de la boîte de dialogue
ci-après :

L'onglet Numérotation permet de définir la numérotation

La boîte de dialogue se compose de trois parties :

• A gauche, le niveau du plan (1 le plus élevé)

• Au centre; les paramètres de définition de la numérotation

• A droite, l'aperçu de la numérotation

Une numérotation de chapitre est liée à un style de paragraphe. 

Si l'on définit une numérotation de chapitre pour un style de paragraphe, par exemple "Titre1", elle est
toujours appliquée lors de l'application du style. Il est possible de définir 10 niveaux de plan maximum.

Ainsi lors de l'application d'un style de paragraphe de plan avec numérotation, la numérotation est
automatiquement mise en place et mise à jour à chaque modification du plan.

On constate que par défaut, OpenOffice.org propose que le niveau 1 soit associé au style de paragraphe Titre
1, 2 pour Titre 2. 

Ainsi qu'il a été indiqué au paragraphe précédent, il est préférable de conserver ces paramètres par défaut qui
permettent de profiter des automatismes définis par défaut dans OpenOffice.org. (Sommaire automatique,
Navigateur)

Pour définir la numérotation correspondant à un niveau il faut:

• Cliquer sur le niveau voulu en partie gauche

• Choisir le « Numéro » correspondant à la numérotation voulue

• Pour les niveaux supérieurs à 1, valoriser le paramètre « Complet ». Ce paramètre permet d'étendre
l'affichage des niveaux supérieurs et d'obtenir l'affichage complet de la numérotation

• Valoriser les autres paramètres (caractères avant et après, numéro de commencement) si besoin est.

• Régler la présentation et les écarts par l'onglet Position.
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L'aperçu affiche au fur et à mesure les diverses interventions sur les paramètres. Dans certains cas il peut être
nécessaire de cliquer sur un autre niveau pour forcer le rafraîchissement de l'aperçu.

Voici le résultat du paramétrage du présent document.

Numérotations spécifiques

L'alternance dans le choix sur le paramètre « Numéro » permet de créer des numérotations de
style de type 1.A.I.a.i.

Le paramètre « Complet » permet de n'afficher que les niveaux supérieurs voulus.

Ainsi dans l'exemple précédent (1.A.I.a.i), si l'on veut que le titre de niveau 5 ne porte que la
numérotation « 1.a.i » il faut valoriser le paramètre « Complet » à 3

Le paramètre « Styles de caractères » permet d'affecter à la numérotation un style différent de
celui affecté au style de paragraphe du titre. Ces styles de caractères sont ceux définis par les
fonctions de styles standard.

Lors de la création de numérotation pour les niveaux supérieurs à 1, ne pas oublier de
valoriser la paramètre « Complet » si vous voulez que votre numérotation soit affichée
entièrement dans le titre, faute de quoi la numérotation sera tronquée..

Enregistrement des numérotations définies

Dans l'onglet Numérotation, le bouton « Format » permet d'enregistrer la numérotation ainsi
définie et de la renommer.

Elle sera ensuite disponible dans toute la suite.
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4.5 - Insertion d'un sommaire automatique

Voici le tableau comparatif de commandes à utiliser pour l'insertion d'un sommaire automatique ou de tables
d'index.

MS Word 97 OpenOffice.org1.0 Texte
Insertion Table et index

Table des matières
Index
Index des illustrations
Index des illustrations
Index des Illustrations

Insertion Index
Index/Table des matières
Index/Index lexical
Index/Index des tables
Index/Index des illustrations
Index/Index des Objets

Pour insérer le sommaire standard, positionner le curseur à l'endroit du texte ou l'index doit être inséré.

Puis, utiliser la commande Insertion>Index>Index. Voici la boîte de dialogue qui apparaît :

A partir de l'onglet « Index », 

• nommer la table des matières (Par défaut, Table des matières) ;

• sélectionner Table des matières dans la liste déroulante « Type » ;

• sélectionner  Créer la table à partir de « structure » ;

• Un clic sur Ok la table des matières est créée.

Modifier la présentation de l'index

Pour modifier la présentation de l'index après sa création, il faut :

• Positionner le curseur sur l'index

• Afficher le menu contextuel

• Choisir Éditer l'index
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Mettre à jour l'index

Pour mettre à jour l'index des modifications apportées au plan ou à la pagination du
document, il faut :

• Positionner le curseur sur l'index, 

• Utiliser la commande Outils>Actualiser>Index Actif

• Ou bien, afficher le menu contextuel, choisir Actualiser l'index

Il est également possible d'actualiser l'index sans positionner le curseur. Utiliser la commande
Outils>Actualiser>Tout actualiser ou Tous les Index.

Ajouter des entrées supplémentaires au sommaire

Il peut être intéressant d'ajouter au sommaire standard des entrées spécifiques correspondant
à partie du document non reprises dans le plan standard.

Ce peut être le cas pour une Introduction, un Préambule, une Conclusion ou tout autre partie.

Pour cela il faut :

• Définir un style de paragraphe pour le titre de cette partie (Le style Titre peut tout à
fait convenir à cet usage)

• Puis dans la boîte de dialogue de définition de l'index sélectionner « Styles
supplémentaires » 

• Cliquer sur le petit carré gris avec trois points ; la boîte dialogue suivante s'ouvrira 

• Chercher dans la liste le style de paragraphe à insérer à la Table des matières, le
décaler vers la droite vers le niveau souhaité avec les flèches
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Modifier les styles des paragraphes d'index

Il peut être intéressant de modifier le style des paragraphes d'index, pour mettre un
espacement entre les titres de niveau 1 et faciliter ainsi la lecture du plan 

• Éditer l'index et choisir l'onglet Styles

• Dans le cadre « Styles de paragraphes » sélectionner le style correspondant au
niveau 1

• Cliquer sur Éditer

• Modifier le style avec la boîte de dialogue qui s'affiche

Comme souvent dans OpenOffice.org, une autre méthode est possible avec le styliste en
affichant tous les styles de paragraphe. 

Le style Table des matières Niveau 1 peut être modifié par la procédure normale. 

4.6 - Insertion de graphiques ou diagrammes

OpenOffice.org permet de créer, d'éditer et de modifier des diagrammes directement. Cet outil ne peut égaler
en termes de complexité et de puissance les résultats obtenus par l'incorporation des diagrammes générés par
un tableur. 

Néanmoins, dans un usage courant de rédaction de rapports, il peut être très utile pour produire des
diagrammes directement incorporés au texte.

Deux solutions sont possibles pour créer un diagramme.

Diagramme à partir d'un tableau existant

Dans ce cas, il suffit de sélectionner la partie du tableau que l'on veut éditer sous forme de diagramme, puis
d'utiliser l'outil Auto format de diagramme.

Exemple

Tr1 Tr2 Tr3 Tr4
Ventes 1 2 3 4

Achats 3 7 5 6

Tr1 Tr2 Tr3 Tr4

0
0,5

1
1,5

2
2,5

3
3,5

4
4,5

5
5,5

6
6,5

7

Ventes et achats

Ventes
Achats
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Pour accéder aux fonctions de manipulations et de modifications du diagramme, il faut sélectionner le
diagramme par un double clic. 

Lorsque le diagramme est entouré d'une bordure grise toutes les commandes de modifications des données et
de la présentation sont accessibles via la barre d'instruments ou les menus contextuels.

Ainsi les manipulations suivantes ont permis de modifier la couleur de la barre du trimestre 2 :

• Double clic sur le diagramme pour le rendre accessible en modification (entouré de carrés verts) 

• Clic simple sur le graphique pour le rendre actif (entouré de carrés verts)

• Clic simple sur la série de données à modifier (suite de carrés bleus)

• Clic simple sur la barre à modifier (entourée de carrés verts)

• Accès par le menu contextuel aux outils de manipulation (pour la couleur : propriétés de l'objet)

Les menus contextuels permettent à chaque étape ci dessus de modifier les propriétés des objets actifs.

De même, la barre d'instruments présente les outils adaptés à la gestion des diagrammes.

Diagramme auto constitué

Dans ce cas on utilise soit le menu Insertion>Objet>Diagramme, ou dans la barre d'instruments. Voici un
exemple de diagramme produit par OpenOffice.org 1.0:

Ligne 1 Ligne 2 Ligne 3 Ligne 4
0

1

2

3

4

5

6

7

8

9

10

Titre principal

Colonne 1
Colonne 2
Colonne 3

Pour accéder aux fonctions de manipulations et de modifications du diagramme, il faut sélectionner le
diagramme par un double clic. 

Lorsque le diagramme est entouré d'une bordure grise toutes les commandes de modifications des données et
de la présentation sont accessibles via la barre d'instruments ou les menus contextuels.

On peut en particulier modifier la valeur des données et les titres en intervenant directement dans un outil
similaire à un tableur. Pour cela il faut sélectionner le choix « Données du diagramme » dans le menu
contextuel.

Ci après un aperçu de l'écran de manipulation des données: 
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4.7 - Réalisation de publipostage

La réalisation de publipostage est fondée sur l'utilisation de deux outils : une source de données ainsi qu'un
composant de fusion des données sur le document principal.

4.7.1 - Source de données

Voici un tableau comparatif des sources de données utilisables dans chacune des suites :

MS Word 97 OpenOffice.org 1.0 Texte
texte texte

Excel classeur 

dBase dBase

Fox Pro

Access ADO

ODBC

JDBC

Carnet d'adresses
(MS Outlook, personnel,
Schedule+)

Carnet d'adresses
(Windows, MS Outlook,
Mozilla/Netscape ou LDAP) 
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Assigner une nouvelle source de données

Pour pouvoir utiliser une source de données, il faut d'abord l'assigner (faire connaître) par
OpenOffice.org.

Pour cela, il faut afficher la boîte de dialogue « Gestion des sources de données » par la
commande Outils>Source de données :

A partir de l'onglet « Général », à gauche, s'affichent les tables déjà créées et repérées par le
gestionnaire de base de données. 

Pour assigner par le panneau de contrôle des données, il faut procéder aux opérations
suivantes :

• Cliquer en haut et à gauche sur « Nouvelle source de données ».

• Dans la partie de droite, lui donner  un nom.

• Sous Connexion, choisir le Type de source de données. 

• Cliquer sur le bouton gris à droite pour sélectionner le fichier de données dans le
répertoire adéquat. Cliquer sur le bouton « Appliquer ». Cliquer sur Ok

4.7.2 - Commandes pour le publipostage

Pour la réalisation d'un publipostage, les deux suites adoptent des démarches assez divergentes, ce qui ne
facilite pas la comparaison.

L'objectif étant d'adresser un courrier à une liste de destinataires répertoriés dans un fichier, MS Word
présente à l'utilisateur un canevas de processus assez linéaire qui permet de franchir pas à pas les différentes
étapes de création d'un publipostage depuis la création de la source de données jusqu'à l'édition du document
final.

Dans le même objectif, OpenOffice.org privilégie l'approche Source de données. L'utilisateur dispose d'un
panneau de contrôle et de manipulation des données qui intègre une barre de gestion des données. Cet outil
permet un accès et une manipulation simple des bases de données référencées.

Tout le publipostage se réalise à partir du panneau de contrôle de la source de données. L'insertion des
champs se fait par glisser/déposer depuis le panneau de contrôle vers le document actif. Le mailing est
effectué en cliquant sur l'icône de la barre de base de données, après sélection des enregistrements désirés.

Ces actions sont bien entendu disponibles dans les menus de commandes.
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Le panneau de contrôle des données se comporte comme un véritable Explorer. Il permet de changer de base
de données et de visualiser le contenu de chacun des enregistrements de la base sélectionnée. Il est possible
par cette interface de réaliser des tris, des sélections, d'appliquer des filtres. OpenOffice.org dispose donc
d'un outil de gestion de données performant et intégré.

Si l'on veut se calquer sur le processus suivi par MS Office, on trouvera ci-après un tableau récapitulatif des
commandes disponibles dans les deux suites

MS Word 97 OpenOffice.org 1.0 Texte
Outils Source de données

Obtenir les données
Ouvrir la base de données

Outils Source de données
/Base de données

Outils Source de données
Obtenir les données

Créer la base de données

Pas de commande équivalente (*)

Outils Source de données
 Obtenir les données

/Ms Query

Outils Source de données 
/Requêtes

Outils Source de données 
Fusion des données

Insérer des champs
Vérifier la fusion
Fusionner sur imprimante
Fusionner dans un fichier

Insertion Champ
Autres

Base de données
Fichier Mailing
Fichier Mailing/Imprimante

Mailing/Fichier
(*) Pour créer un fichier de données, il suffit de créer un document :

• soit avec OpenOffice.org 1.0 Texte dans un tableau, de le convertir en texte et de l'enregistrer en
fichier texte ;

• soit avec OpenOffice.org 1.0 Classeur. Le fichier est enregistré au format sxc.

4.7.3 - Exemple d'une lettre avec publipostage à partir d'un classeur Calc

Pour effectuer un mailing sous OpenOffice.org, il faut disposer d'une source de données ou autrement dit
d'un fichier comportant la liste des enregistrements qui serviront à faire le mailing

L'opération de mailing consistera donc à insérer dans une lettre-type des champs provenant de la source de
données, puis à créer automatiquement toutes les lettres correspondant à ces enregistrements.

L'outil utilisé pour réaliser cette opération est le panneau de contrôle de sources de données 

Voici le détail des opérations nécessaires pour effectuer un publipostage.

Création de la source de données au format Calc

Pour créer une feuille de calcul au format on peut soit importer une feuille de calcul venant d'un autre
tableur, soit encore mieux créer une feuille de calcul.

Chaque colonne sera reconnue comme un champ de base de données. Sur la première ligne du fichier doivent
figurer le nom des champs de la base de données.

Enregistrez votre feuille dans le répertoire désiré au format (.sxc) et fermez

Assignation de la source de données

Afficher la boîte de dialogue « Gestion des sources de données » par la commande Outils>Source de données
:
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A partir de l'onglet « Général », à gauche, s'affichent les tables déjà créées et repérées par le gestionnaire de
base de données. 

Pour assigner par le panneau de contrôle des données, il faut procéder aux opérations suivantes :

• Cliquer en haut et à gauche sur « Nouvelle source de données ».

• Dans la partie de droite, donner lui un nom.

• Sous Connexion, choisir le Type de source de données. Pour le présent exemple, dans le menu
déroulant, choisir « Classeur »

• Cliquer sur le bouton gris à droite pour sélectionner le fichier de données dans le répertoire
adéquat. Cliquer sur le bouton « Appliquer ».

• Cliquer sur Ok pour fermer. La source de données est maintenant disponible

Création de la lettre type

• Ouvrir un nouveau document texte : Fichier>Nouveau>Texte 

• Taper le corps de la lettre. Il n'est aucunement besoin de rentrer les champs d’adresses en même
temps que la frappe 

• Une fois cette lettre saisie, l'enregistrer et la laisser affichée à l’écran.

Insertion des champs

• Dans le menu 'Affichage', sélectionner 'Source de Données' (ou tapez sur F4). Cette
commande appelle l'ouverture de panneau de contrôle de données ou Beamer

Le panneau de contrôle affiche la liste des sources de données.
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• Sélectionner la source de données dans l'explorer situé à gauche. Cliquer sur la petite croix à côté
pour déployer son arborescence. Renouveler cette opération pour la rubrique « Tables ».

Cliquez sur le nom de la table (ici feuille1), les noms de champs et les enregistrements s'affichent
dans la partie droite du Beamer.

• Pour ajouter les champs dans le document type, cliquer sur l'en-tête de la colonne choisie, sans
relâcher le doigt, glisser la souris jusqu’à l'endroit voulu pour l'insertion dans la lettre. Le champ
s’affiche dans votre document 

• Procéder de la même manière pour tous les champs à insérer. Effectuer la mise en forme (retraits,
alignements, effets de caractère, police, etc).

Voici le résultat de l'insertion des champs dans une lettre standard

Contrôle de la mise en page

Il est très intéressant de visualiser le résultat de l'insertion et de la mise forme des champs avec un ou
plusieurs exemples d'enregistrements issus de la base de données.

Pour ce faire, il faut utiliser la barre d’outils du Beamer :
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La troisième icône en partant de la droite  s’appelle ‘Données dans les champs’. 

• Sélectionner un enregistrement en cliquant sur le rectangle gris à gauche de l'enregistrement choisi 

• Cliquez sur l’icône « Données dans les champs », les champs de la lettre type vont se remplir de
l’enregistrement sélectionné.

L’opération peut être répétée autant de fois que nécessaire, en changeant éventuellement d'enregistrement de
test, pour contrôler la mise en page et ajuster la lettre type en fonction du contenu des champs (longueur, ...).

Fusion/Mailing

Si l'on souhaite effectuer un publipostage ne comprenant que quelques enregistrements sélectionnés il faut
procéder de la manière suivante :

• Pour sélectionner une plage d'enregistrements, sélectionner le premier puis le dernier en maintenant
la touche Maj enfoncée.

• Pour sélectionner plusieurs enregistrements dispersés dans la table, maintenir la touche CTRL, en
même temps que vous effectuez votre sélection.

Si le publipostage concerne tous les enregistrements de la table, on peut :

• soit cliquer sur le coin  en haut et a gauche de la liste des enregistrements

• soit choisir l'option « Tous » dans la boîte de dialogue de mailing 

Pour effectuer le mailing, 

• cliquer sur l'avant dernière icône de la barre d’outils du Beamer (celle qui représente des
enveloppes)

La boîte de dialogue suivante est affichée :

• Choisir tous ou laisser l'option « Enregistrements marqués » s'ils ont déjà été sélectionnés à l'étape
précédente

• Ensuite choisir le périphérique de sortie sur lequel le mailing doit être effectué 

Si l'on choisit « Fichier », comme dans l'exemple, sélectionner le chemin d'enregistrement du
fichier en cliquant sur l’icône avec les trois petits points en naviguant dans l’arborescence.

Il est possible de nommer ce document par n’importe quel champ de la base de données ou par un
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nom spécifique saisi manuellement.

Le mailing va créer un document par enregistrement. 

Après enregistrement ou fermeture de la lettre-type, il n'est plus possible d'insérer des champs
avec le glisser/déposer des en-têtes de colonne. Le curseur reste en forme de « sens interdit »
lorsque il est placé sur la lettre au lieu du carré avec un signe +

Pour pouvoir insérer des champs selon cette méthode, il faut rendre la lettre-type
« Éditable ». Pour cela il suffit de cliquer sur l'icône « Édition de fichier » située en 2ème
rang à gauche sur la barre de fonctions.

Néanmoins, les autres méthodes d'insertions par le menu ou l'icône de la barre d'instruments
sont toujours disponibles dans toutes les situations.

4.7.4 - Réalisation d'étiquettes à partir d'un fichier d'adresses

Ce type de publipostage permet de créer des étiquettes auto-collantes comportant une adresse, par exemple,
pour les mailings non adaptés aux enveloppes à fenêtre. Il se déroule en trois étapes

• Sélection du type d'étiquette et de la base de données

• Création d'une étiquette type par inclusion des champs et mise en forme

• Extension de la présentation à toute la feuille d'étiquette

• Mailing ou sélection des enregistrements

Voici ci après la procédure dans son détail :

Sélection du type d'étiquette et de la base de données

1. Par la commande Fichier>Nouveau>Étiquettes, ouvrir la boîte de dialogue Étiquettes.

2. Dans l'onglet Étiquettes, sélectionnez le format des feuilles d'étiquettes à imprimer, la marque en
premier puis le type. 

3. Dans l'onglet Options, cocher la case Synchroniser le contenu. 

4. Fermez la boîte de dialogue à l'aide de Nouveau document.

5. Lorsque l'étiquette apparaît, ouvrez le panneau de contrôle des données avec la touche (F4). 

Pour voir le haut de la page d'étiquettes, en cas de besoin, ancrez le panneau de contrôle des

données en cliquant sur l'icône .

6. Sélectionnez, dans la vue des sources de données, la table de votre source de données d'adresses.

Création d'une étiquette type

1. Insérez les champs nécessaires de la source de données, 

Pour cela, ouvrez la boîte de dialogue « Champs », avec le raccourci clavier (Ctrl) (F2) ou l'icône
de la barre d'instruments, et passez ensuite à l'onglet « Base de données ».
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Sélectionnez « Champ de mailing », sélectionnez la source de données et insérez les champs
voulus.

Vous pouvez aussi insérer les champs par le menu Insertion>Champs>Autres ou l'icône de la barre
d'instruments.

2. Insérez un champ « Enregistrement suivant » 

Pour cela, placez le curseur sur la dernière position du texte (à la suite du dernier champ) dans la
première étiquette, dans la boîte de dialogue « Champs » sélectionnez « Enregistrement suivant » et
cliquez sur le bouton Insérer et Fermer.

3. Faites la mise en forme sur cette première étiquette (retraits, alignements, interlignes, gras, etc)....
Cette première étiquette (Master Label dans le Navigateur) détermine la présentation de toutes les
autres, c'est uniquement sur celle-ci qu'il faut intervenir pour l'insertion des champs.

Le champ « Enregistrement suivant » est seulement signalé par un petit carré gris peu visible.

Attention donc à ne pas l'insérer plusieurs fois ou le supprimer par inadvertance.

Après la dernière étiquette d'une page, la commande Enregistrement suivant est
automatiquement exécutée. Il n'est pas donc pas nécessaire d'exécuter cette commande
manuellement après la dernière étiquette de la page.

Extension de la présentation

Vous pouvez maintenant synchroniser les étiquettes. Cliquez sur le bouton Synchroniser dans la petite
fenêtre.

La présentation de la première étiquette s'étend à toute la feuille.

Mailing ou sélection des enregistrements

1. Pour éditer tous les enregistrement de votre source de données, Cliquer sur l'icône Mailing du
panneau de contrôle des données ou utilisez la commande Fichier> Mailing

Le panneau de configuration du Mailing est utilisable dans les mêmes conditions

2. Pour éditer les seuls enregistrements pour lesquels vous souhaitez créer des autocollants d'adresse
sélectionnez-les dans l'affichage de la base de données en cliquant à gauche dans les en-têtes de
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ligne. 

Utilisez la touche (Maj.) ou (Ctrl) de la manière habituelle pour sélectionner plusieurs
enregistrements simultanément.

Dans la barre de base de données, cliquez sur l'icône Données dans les champs . Vous
pouvez ensuite enregistrer et/ou imprimer l'étiquette.
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5 - LE TABLEUR

Cette partie détaille les fonctionnalités spécifiques aux tableurs de chaque suite. La comparaison porte sur les
modalités d'utilisation des tableurs et les commandes correspondantes de menu ou de raccourci clavier. 

Le principe de fonctionnement du tableur étant largement établi, l'aspect général des deux suites est
quasiment identique. 

Une feuille de calcul présente un tableau de cellules numérotées en ligne (lettres) et en colonne (chiffres).
Les feuilles de calcul du classeur sont adressables par des onglets en bas d'écran

L'introduction de valeurs dans une cellule se fait de la même façon dans les deux suites par saisie directe ou
dans la zone de saisie. 

De même, les calculs sont réalisés selon les mêmes principes. Dans une cellule, peuvent s'effectuer des
calculs sur des valeurs brutes ou le contenu de cellules adressées en position absolue ou relative.

Des outils permettent la totalisation rapide en ligne et colonne permettent d'établir très aisément des tableaux
à double entrée.

Les deux suites disposent d'un outil de création de graphiques ou diagrammes simple d'utilisation.

Toutefois, le tableur de la suite OpenOffice.org est limité dans sa version actuelle à 32000 lignes (Excel
65000 lignes).

5.1 - Commandes comparées pour la réalisation de feuilles de calcul. 

Les tableaux ci-après font la comparaison des commandes contenues dans les menus des deux Tableurs. Ils
ne sont que le fruit d'une expérience d'utilisateur et ne sont pas exhaustif des capacités complètes des tableurs
comparés.

Les fonctions commentées sont notées par un dièse (#) et font l'objet d'une explication complémentaire après
chaque  fin de tableau.

Les raccourcis sont donnés à part et les combinaisons de touches sont notées en gras souligné. 

Par exemple : Un nouveau Fichier peut s'appeler par le raccourcis Ctrl+N ou par Alt+F puis N.

A noter que certains raccourcis ne sont pas mentionnés dans les menus comme Fermer (Ctrl+W). Ils sont
mentionnés quand même tant que faire se peut.

La liste complète est disponible dans l'aide de OpenOffice.org. ou sur le site francophone.

Dans la comparaison, la priorité est donnée à l'utilisateur Excel en lui donnant l 'équivalent OpenOffice.org.
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5.1.1 - Menu Fichier

MS Excel 2000 (installation standard) OpenOffice.org1.1 Calc
Menu Clavier Menu Clavier

Fichier 
...# Nouveau
... Ouvrir
... Fermer...
... Enregistrer 
... Enregistrer sous
... Enregistrer (...) page Web

 
...# Enregistrer un

environnement
...# Aperçu de la page Web
...# Mise en page
...# Zone d'impression.
... Aperçu avant impression
... Imprimer
... Envoyer vers 
... Propriétés

... (Derniers fichiers ouverts)

... Quitter

(pas de commande équivalente)
(Voir Fichier Nouveau)

Ctrl N
Ctrl O
Ctrl W
Ctrl S

Ctrl P

Fichier
... Nouveau (ou Autoplilote )
... Ouvrir
... Fermer...
... Enregistrer
... Enregistrer sous
... Enregistrer sous

Type Page Web
(pas de commande équivalente)

(pas de commande équivalente)
Format Page
... Zones  d'impression
Fichier Aperçu
... Imprimer...
...  Envoyer 
...  Propriétés 

... (Derniers fichiers ouverts)

...  Quitter

Particularités du menu OpenOffice.org
... Tout enregistrer
... Autoplilote

Ctrl N
Ctrl O
Ctrl W
Ctrl S

Ctrl P

Ctrl Q

Nouveau

La fonction Nouveau d’Excel amène une boite de dialogue que l’on obtient aussi avec la fonction
Autoplilote de OpenOffice.org.

Enregistrer un environnement

Dans le tableur Excel, la fonction Enregistrer un environnement consiste à enregistrer dans un fichier
quelques paramètres de la fenêtre en cours (taille, position) et fichiers ouverts, etc. On rappelle tout (fichiers
et apparences) en ouvrant un fichier à l’extension “xlw”. Elle n’a, a priori, pas d’équivalent sous
OpenOffice.org dans lequel elle ne présente aucune utilité. 

En effet, OpenOffice.org enregistre nativement tous ces paramètres et restitue la taille et la position du
fichier à son ouverture.

Aperçu de la page Web

Avec Excel, Fichier - Aperçu de la page Web génère un fichier
HTML de la page en cours, dans le dossier “Temp” de l'utilisateur
qu'il visualise avec le navigateur par défaut du système. 

Avec OpenOffice.org on obtient le même résultat mais par Fichier -
Enregistrer sous puis Type = Page Web”.

La différence c'est que vous travaillez en format “Html” au lieu du
format tableur “sxc” mais il vous faut voir le résultat final avec un
navigateur.
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A la première sauvegarde de votre travail, vous aurez droit à une mise en garde sur la transformation du
format “xml” vers le “Html” avec les possibles pertes de format.

Illustration de cette procédure.

Vous remarquez que vous ne sortez pas du Tableur (1) tout en travaillant sur du Html.

Attention : Dès que vous fermez votre fichier, OpenOffice.org le considère comme un fichier Html classique
et ce n’est plus le Tableur mais le module Editeur Html qui se chargera de l’ouvrir.

Tout enregistrer

Particularité de OpenOffice.org, cette fonction apparaît dans le menu Fichier à l’ouverture de plusieurs
documents et vous offre la possibilité de faire un enregistrement du groupe des fichiers ouverts.

Autopilote

A vrai dire, cette fonction est à différencier car Fichier – Nouveau de OpenOffice.org permet d’accéder
aussi à tout module (texte, maths, html, présentation, etc.) et Fichier – Autopilote vous offre une assistance
sur la base de modèles divers (fax, lettres, import divers, etc.). Si l’on doit faire une équivalence il faut plutôt
chercher vers le “Gestionnaire de document” de la suite Microsoft.

Si vous utilisez ce genre de fonction préférez, avec OpenOffice.org, l’utilisation du Lanceur.

Il se trouve sur la barre de tâches.

Son usage est très simple car il s’installe automatiquement à
l’installation ou au premier lancement d’OpenOffice.org.
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Deux options possibles :

• Fichiers : un clic droit dessus

• Modèles : double clic gauche dessus.

Mise en page 

Pour préparer facilement vos mises en page avec OpenOffice.org vous pouvez mettre les marges à zéro ; le
message d’avertissement permet (si vous répondez Non) de récupérer les marges “vraies” de l’imprimante.
Vous êtes ainsi assuré d’imprimer sans perte tout en utilisant les capacités de votre imprimante.

Exemple : 
Ici une Canon S450.

(Excel autorise les marges à zéro
sans rien dire et ne vous donne pas
les marges de l’imprimante. A
l’impression vous n'aurez un
message que si la page à l’écran
dépasse les capacités de
l’imprimante.)

Avec Excel il est délicat de savoir si les sauts de pages sont le reflet des capacités de l'imprimante.

En effet, Excel accepte les marges à zéro sans message d'alerte et il ne récupère pas les marges de
l'imprimante. Toute adaptation des sauts de pages à la souris, dans le document, passe par un zoom qui n'est
pas forcément voulu par l'usager.

OpenOffice.org vous donne les marges de l'imprimante (version Windows) ce qui permet de les paramétrer
très précisément. Dans notre cas (Canon S450) on peut mettre toutes les marges à 0,50cm pour les
harmoniser. Les sauts de pages respecteront ce réglage. Sur un Tableur on passe toujours beaucoup de temps
à régler le document pour une bonne mise en page.
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Zone d’impression

Pour Excel la zone d’impression est une zone que vous sélectionnez, puis elle reçoit un nom
(zone_d_impression) ; elle est gérée comme une simple cellule (ou groupe de cellules) nommée. D’ailleurs
vous pouvez la modifier avec la fonction Insertion – Nom – Définir  mais elle est unique par feuille.

Pour OpenOffice.org les Zones d’impression sont définies dans le menu Format – zone d’impression. Cela
permet de créer et gérer les zones d’impression du document. En effet elles peuvent être multiples.

Voir aussi le menu Affichage – Aperçu des sauts de pages.

5.1.2 - Menu Édition

MS Excel 2000 (installation standard) OpenOffice.org1.1 Calc
Menu Clavier Menu Clavier

Édition
... Annuler
... Répéter

... Couper

... Copier

... Coller

... Collage spécial

...# Collage (...) hypertexte

... Recopier

... Effacer

...# Supprimer

...# Supprimer une feuille

... Déplacer copier une
feuille

... Rechercher

... Remplacer

...# Atteindre

...# Liaisons

...# Objet (suivant l'objet)

Outils Suivi des modifications
Outils Fusionner les classeurs
Affichage En-têtes et pieds de page
( Absent ! mais Raccourcis valide )
Insertion Supprimer / Saut de page

Ctrl Z
Ctrl Y

Ctrl X
Ctrl C
Ctrl V

Ctrl F
Ctrl H
Ctrl T

Ctrl A

Édition
Annuler

... Répéter

... Couper

... Copier

... Coller

... Collage spécial
Insertion Hyperlien

Édition Remplir
... Supprimer du contenu
... Supprimer des cellules
... Supprimer la feuille
... Déplacer/copier la feuille

... Rechercher et remplacer

...       '' - ''

... Navigateur

... Liens

... Objet (suivant l'objet)

Particularités du menu OpenOffice.org

... Modifications

... Comparer le document

... En-têtes et pieds de page

... Sélectionner tout

... Supprimer le saut manuel

Ctrl Z
Ctrl Y

Ctrl X
Ctrl C
Ctrl V

Suppr.

Ctrl F

F5

Ctrl A

Collage comme lien Hypertexte

Cette fonction est invalide sur la version testée 1.1 de OpenOffice.org, l’équivalent Insertion – Hyperlien
est donné à titre indicatif mais devrait satisfaire la majorité des utilisateurs. On peut utiliser aussi le
Navigateur.

Effacer

Pour Excel la fonction Effacer offre des choix. 
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Avec OpenOffice.org vous l’avez disponible directement par la touche Suppr de votre clavier. Veuillez
noter que la touche Retour arrière (Backspace) permet un effacement sans choix. Des combinaisons avec
les touches Ctrl et Maj sont possibles mais bien souvent les systèmes et logiciels installés (souris),
contrarient ces options. A vous de les explorer.

NOTA : La touche F2 quant à elle, permet d’éditer le contenu des cellules sans en effacer le contenu.

Supprimer une feuille

Comme dans tous ces tableurs l’usage du bouton droit de la
souris sur un objet permet d’accéder à un menu contextuel
qui donne les principales fonctions disponibles.

Cela remplace avantageusement le menu.

NOTA: Pour renommer une feuille ...

Sur Excel un double clic gauche sur le nom.

Sur OpenOffice.org  Alt+clic gauche.

Atteindre

Cette fonction d’Excel permet
d’atteindre des cellules et repose
principalement sur les cellules nommées.

Mais en seconde option le bouton
Cellules permet plus encore. Là nous
avons affaire à une recherche
discriminatoire selon des critères
multiples.

Dans OpenOffice.org, on est tenté
d’opposer les capacités du Navigateur
(F5) car il permet d’atteindre tous les
objets constituant notre document.

A priori il ne permet pas de sélectionner
les cellules selon tous les critères que
propose Excel.

Voici quelques méthodes de substitution:

Excel OpenOffice.org 
Commentaires 

Constantes
Formules

Objets 

Dernière cellule

Navigateur - Notes

Affichage - Valeurs
formules    = vert
Constantes = bleu

Navigateur – Objet Ole
Navigateur – Images
Navigateur – Dessin

Dernière cellule (Zone)

Dernière cellule (ligne)
Première cellule (ligne)

F5

Ctrl F8

F5

Ctrl Fin

fin
début
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Liaisons

Cette fonction est automatisée avec Excel dans le sens où la liaison est mise à jour automatiquement par
défaut. OpenOffice.org suppose que l’utilisateur veut une automatisation et qu’il gère le type de lien, aussi
par défaut le lien n’est pas dynamique. Quitte à comparer, OpenOffice.org ressemble plutôt aux logiciels de

CAO sur ce  sujet !.

Une liaison dynamique sous OpenOffice.org se réalise par le menu Édition – Collage spécial et l’option
Lier.

Ne pas oublier que pour OpenOffice.org la liaison avec des données externes est
gérée par :

• Liaison : Il faut faire un rafraîchissement des données à l'aide du menu
Édition – Liens – Actualiser

Contenu de la cellule : =’file:///C:/data.sxc’#$Feuille1.D8

• Insertion de données : Il faut passer par le menu Insertion. Similaire à la
précédente mais aucune formule ou chemin n'apparaît, seulement la donnée
demandée. Même méthode pour le rafraîchissement du lien.(voir les
commentaires du menu Insertion)

Contenu de la cellule : Contenu de la donnée externe

• Liaison dynamique : Il faut passer par Édition - Collage spécial – Lier.
Contenu de la cellule : =DDE(« soffice »; « C:\data.sxc »; « Feuille1.D8 »)

NOTA : L’actualisation des liens par Édition – Liens n’est pas globale mais
individuelle contrairement à l’actualisation proposée à l’ouverture du fichier.

Objet

Cette fonction n’est valide qu’après insertion d’un objet. Voir Insertion – Objet.
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5.1.3 - Menu Affichage

MS Excel 2000 (installation standard) OpenOffice.org1.1 Calc
Menu Clavier Menu Clavier

Affichage 
... Normal
...# Aperçu des sauts de page
... Barres d'outils
... Barres de formule
... Barres d'état

... En-têtes et pieds de page

...# Commentaires

... Affichages personnalisés

... Plein écran

...# Zoom
(pas de commande équivalente)
Outils Options ...
(pas de commande équivalente)

Affichage
... (Par défaut)
... Aperçu des sauts de page
... Barres d'outils
... Barres d'outils ... Calculs
... Barres d'état

Édition En-têtes et pieds de page
Insertion Note (gestion = clic droit)

(pas de commande équivalente)
... Plein écran 
... Zoom
... Source de données
... En-têtes colonnes/lignes
... Mise en évidence valeurs

Ctrl Maj j
Ctrl molette
F4

Ctrl F8

Aperçu des sauts de page

Cette fonction sous OpenOffice.org
est similaire à celle sous Excel.

Rappels utiles :

• La numérotation (Page 1, etc.)
n'est pas le reflet de l'ordre
d'impression mais de la position
dans la feuille.

L'impression de la page 1 à
l'aide de Fichier – Imprimer
déclenche , en fait, l'impression
de la première page de la
première feuille (feuille1).

Vous avez une option
disponible dans Outils -
Options – Classeurs –
Impression – feuilles.

• Vous agrandissez la zone à imprimer avec les lignes bleues en périphérie.

• Les lignes intérieures en bleu foncé sont les sauts de pages. Les toucher consiste à faire un zoom pour
l'impression. Elles sont calculées sur la base des marges (Format – Page).

• La zone en gris n'est pas imprimée mais elle peut être utilisée sans restriction.

• Vous pouvez aussi passer par le menu Format – Zone d'impression pour définir vos zones sans basculer
l'affichage. Les pages ainsi définies sont matérialisées par des lignes foncées.
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Commentaires

Cette fonction d’Excel est nommée Notes sous
OpenOffice.org et elle apparaît aussi quand la
cellule est survolée par le curseur de la souris. Il
n’y a pas de grandes différences si ce n’est la
procédure de gestion qui passe aussi par le clic
droit sur la cellule et qui ne vous offre qu’une
option : Afficher la note. Une fois affichée, il
vous suffit de cliquer sur la note pour l’éditer.

Astuce : Si vous voulez une note qui s’affiche
avec la sélection de la cellule plutôt qu’avec le
curseur de la souris utilisez la fonction Données
– Validité – Aide à la saisie.

Zoom

Cette fonction est toujours disponible sous OpenOffice.org
en bas de votre fenêtre par un pourcentage affiché. Elle ne
se déroule pas sous forme de liste de choix comme sous
Excel mais par le clic droit ou le double clic gauche pour
plus de choix.

Astuce : Plus rapide la combinaison de la touche Ctrl +
molette de la souris.

(Dépendante du système et de réglages divers).

5.1.4 - Menu Insertion

MS Excel 2000 (installation standard) OpenOffice.org1.1 Calc
Menu Clavier Menu Clavier

Insertion
... Cellules
... Lignes
... Colonnes
... Feuille
... Graphique
... Saut de page

... Fonction

... Nom

... Commentaires

... Images

... Objets

... Liens Hypertexte

(pas de commande équivalente)
... Voir Liens
... Utilisez l'entrée 'Fonction'
(pas de commande équivalente)

Ctrl K

Insertion
... Cellules
... Lignes
... Colonnes
... Feuilles
... Diagrammes
... Saut manuel

... Fonction 

... Noms

... Notes

... Images

... Objet

... Hyperlien
Particularités du menu OpenOffice.org
... Caractères spéciaux
... Données externes
... Liste des fonctions
... Frames

Ctrl F2

Pas de commentaires particuliers à faire car la totalité des fonctions sont présentes et sont similaires ce qui
doit permettre à un utilisateur d’Excel d’être à l’aise. 
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Pour les fonctions complémentaires de OpenOffice.org consultez l’aide. En bref :

Caractères spéciaux: Vous pouvez insérer des
caractères comme dans un traitement de texte.

Données externes: Vous pouvez faire une sorte
de copier coller avec liaison. La liaison
n’apparaît pas sous forme de formule mais bien
sous forme de texte ou chiffre bien qu’elle soit
gérée comme un lien et rafraîchie à chaque
ouverture de fichier (voir les captures).

Liste des fonctions: Rien A Signaler.

Frames ou cadre: Pour insérer un document modifiable
depuis votre document.
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5.2 - Menu Format

MS Excel 2000 (installation standard) OpenOffice.org1.1 Calc
Menu Clavier Menu Clavier

Format 
...# Cellule
... Ligne
... Colonne
... Feuille

... Mise en forme Aut.

...# Mise en forme Cond.

...# Style

(pas de commande équivalente)
Barre d'outils 'Fusionner centrer'
Fichier Mise en page
... Zone d'impression...
(pas de commande équivalente)

#Format Style

Format
... Cellule
... Ligne
... Colonne
... Feuille

... Autoformat

... Formatage conditionnel

... Styliste
Particularités du menu OpenOffice.org
... Par défaut
... Fusionner les cellules
... Page
... Zone d'impression
... Casse / caractères

... Catalogue des styles

F11

Ctrl Y

Cellule

Cette fonction est similaire aussi mais avec quelques nuances dont voici un aperçu ...

OpenOffice.org considère que l’écran et l’imprimante sont deux sorties possibles pour afficher une cellule.

Par exemple le zéro peut se voir ou non en
Option – Classeur – Affichage mais aussi
en impression dans les réglages de la page
(Format – Page – Classeur). Ces réglages
sont valables pour toutes les feuilles du
classeur et chaque classeur peut avoir ses
réglages.

Il devient logique de considérer qu’une cellule peut aussi
avoir son réglage pour l’impression indifféremment de son
affichage à l’écran. Vous pouvez demander que des cellules
ne soient pas imprimées, toutefois cela s’applique au contenu
mais pas aux autres formats (bordures, trames).
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Mise en forme conditionnelle

Sous Excel vous avez droit à trois formats conditionnels par cellule, format que vous définissez dans la
foulée. A l’usage quelle différence  avec OpenOffice.org ?

OpenOffice.org considère que les
formats à appliquer se gèrent
AVANT, à l’aide du Styliste.

Il vous faut donc les créer avant pour
en disposer après dans les formats
conditionnels.

Ils seront ainsi disponibles sous forme
de liste déroulante dans la boite de
dialogue des formats conditionnels.

Style

Le formatage conditionnel, donc, souligne la différence entre Excel et OpenOffice.org.

En effet dans OpenOffice.org, les styles sont disponibles partout et font partie intégrante de la suite.

Autre exemple, pour modifier un style avec Excel il faut en créer un autre avec le même nom.

La procédure n’est pas une modification mais un effacement suivi d’une création de style.

Avec OpenOffice.org avez vraiment accès au style que
vous pouvez vraiment modifier.

Pour l’utilisateur cela ne change pas grand chose mais cela
souligne que dans le cadre d’une migration vers
OpenOffice.org il est difficile d’ignorer les styles.

Hormis cette différence il est à noter que les styles
s’appliquent aussi aux pages. Vous pouvez gérer vos
styles de cellules et vos styles de pages.

Ainsi dans le cadre d’une structure où plusieurs personnes
génèrent des documents, il est possible de définir une
charte graphique.

Il est donc difficile de dire que la fonction style d’Excel
trouve son équivalent, au regard de l’importance de cette
fonctionnalité dans OpenOffice.org.
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5.3 - Menu Outils

MS Excel 2000 (installation standard) OpenOffice.org1.1 Calc
Menu Clavier Menu Clavier

Format 
...# Cellule
... Ligne
... Colonne
... Feuille

... Mise en forme Aut.

...# Mise en forme Cond.

...# Style

(pas de commande équivalente)
Barre d'outils 'Fusionner centrer'
Fichier Mise en page
... Zone d'impression...
(pas de commande équivalente)

#Format Style

Format
... Cellule
... Ligne
... Colonne
... Feuille

... Autoformat

... Formatage conditionnel

... Styliste
Particularités du menu OpenOffice.org
... Par défaut
... Fusionner les cellules
... Page
... Zone d'impression
... Casse / caractères

... Catalogue des styles

F11

Ctrl Y

Partage

Cette fonction n’est pas disponible dans OpenOffice.org mais il vous est possible de travailler en mode
Version de votre document. Cela vous offre la possibilité de travailler à plusieurs sur votre document, pas en
même temps, il est vrai.

Macro

La version 1.1 de OpenOffice.org a son enregistreur de macro mais la compatibilité avec le VBA d’Excel
s’arrête là. C’est un choix technique (et de sécurité).
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5.3.1 - Menu Données

MS Excel 2000 (installation standard) OpenOffice.org1.1 Calc
Menu Clavier Menu Clavier

Données
... Trier
... Filtre
... Grille
... Sous-totaux
...# Validation

... Table

... Convertir

... Consolider

... Grouper et créer un plan

... Rapport de tableau croisé

... Données externes

... Actualiser les données

Données
... Trier
... Filtre
(pas de commande équivalente)
... Sous-totaux
... Validation

(?)
(pas de commande équivalente)
... Consolider
... Plan - Grouper

.... Pilote de données – Activer

Insertion Données externes
Édition Liens

F12

Validation

La validation des données est parfois utilisée pour sa gestion des listes
déroulantes.

OpenOffice.org offre une autre méthode de gestion des listes
déroulantes.

Par défaut, tout texte dans une colonne est
disponible par le raccourci Ctrl D. La liste filtre
les textes par ordre alphabétique et exclue
(contrairement à Excel) les chiffres et formules.

Nota: Dans cet exemple le ‘texte formule’ est
obtenu par la formule : =’’texte formule’’.

L’ergonomie de cette fonction et ses capacités
sont différentes. On est à mi-chemin entre la Liste
de choix d’Excel qui a besoin d’être chaînée à ses
données et la Validation de donnée qui est moins
dépendante de l’origine des données.

Sous OpenOffice.org, on peut imaginer une
solution mixte avec la fonction Données externes
mais on reste avec une liste de textes.

Pour les utilisateurs avertis il existe une solution mais qui passe
par une macro qui de toute façon reste différente de l’ergonomie
sous Excel.

Pour la mise oeuvre d’une telle solution, un document sera (est)
disponible dans la section documentation du site de
OpenOffice.org.
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5.3.2 - Menu Fenêtres

MS Excel 2000 (installation standard) OpenOffice.org1.1 Calc
Menu Clavier Menu Clavier

Fenêtre
... Nouvelle fenêtre
... Réorganiser
... Masquer
... Afficher

... Fractionner

... Figer les volets

... ( Liste des fichiers ouverts
)

Fichier Fermer... Ctrl W

Fenêtre
... Nouvelle fenêtre
(pas de commande équivalente)
(pas de commande équivalente)
(pas de commande équivalente)

... Scinder

... Fixer

... ( Liste des fichiers ouverts )

Particularités du menu OpenOffice.org
... Fermer la fenêtre Ctrl W

Pas de commentaires particuliers à faire si ce n’est que les fichiers s’ouvrent dans une fenêtre similaire à leur
taille du dernier enregistrement ce qui constitue une option à mi-chemin entre Environnement et Afficher
d’Excel. Pour les fonctions complémentaires de OpenOffice.org consultez l’aide.

5.4 - Ergonomie de travail

5.4.1 - Souris

OpenOffice.org ne fait pas une débauche de combinaisons possibles (clavier / souris) pour travailler comme
Excel. 

En général le bouton droit de la souris est réservé au menu contextuel de l'objet désigné et c'est tout.

Les combinaisons se trouvent plutôt avec le bouton gauche et la molette de la souris.

Par exemple : clic droit sur les feuilles = le menu contextuel

clic gauche = Sélection

Ctrl+clic gauche = (Dé)sélection multiple

Alt+clic gauche = Renommer

Pour les connaître toutes consultez l'aide.

5.4.2 - Cellule

OpenOffice.org fait une différence entre sélection et focus contrairement à
Excel qui fusionne à l'usage ces deux notions. Cela peut dérouter au début.
Voyons cela sur une cellule.

clic gauche sur une cellule = Sélection

Mais pour déplacer cette cellule la sélection n'est pas suffisante il faut lui
donner le focus.

Maj + clic gauche sur une cellule = Focus

Quand une cellule reçoit le focus on peut agir sur la cellule, la déplacer par exemple.

Page 61/84 Version 1.0.1 du 24/06/2003

Sélection



Pour cela : positionnez le focus sur une cellule (ou groupe
de cellules) puis cliquez gauche sur la cellule (pas besoin de
viser la bordure comme sur Excel) et déplacez le curseur.

La combinaison du déplacement avec Ctrl permet de
transformer le déplacement en copie, signalée par le signe
plus (+) à côté du curseur de la souris.

En fait sélection et focus sont différents comme le sont les
verbes désigner et attraper. 

NOTA : Une sélection multiple de cellules déclenche
automatiquement le focus sur la sélection.

5.4.3 - Raccourcis

Sous Excel quelques raccourcis sont beaucoup utilisés comme F4 pour répéter la dernière action. Sous
OpenOffice.org ce raccourci n'est pas valide mais il se paramètre très facilement par le menu Outils –
Adaptation – Clavier (catégorie : Édition, Fonction : Répéter ) sur la touche F3 car la touche F4 est déjà
utilisée.

F4 sous Excel a une autre fonction c'est la transformation des références relatives en références absolues
quand vous êtes dans une formule. Sous OpenOffice.org c'est la combinaison Maj + F4.

5.5 - Utilisation de fonctionnalités complexes 

5.5.1 - Liste des opérateurs

OpenOffice.org Calc permet l'utilisation des opérateurs mentionnés ci-après.
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Opérateurs arithmétiques

Ces opérateurs renvoient des résultats numériques.

Opérateur Nom Exemple
+ (Plus) Addition 1+1
- (Moins) Soustraction 2-1
- (Moins) Négation -5
* (Astérisque) Multiplication 2*2
/ (Barre oblique) Division 9/3
% (Pourcentage) Pourcentage 15%
^ (Accent circonflexe) Puissance 3^2

5.5.2 - Opérateurs de comparaison

Ces opérateurs renvoient la valeur logique VRAI ou FAUX.

Opérateur Nom Exemple
= (Égal) Égalité A1=B1
> (Supérieur à) Supérieur à A1>B1
> (Inférieur à) Inférieur à A1<B1
>= (Supérieur ou égal à) Supérieur ou égal à A1>=B1
<= (Inférieur ou égal à) Inférieur ou égal à A1<=B1
<> (Différent de) Inégalité A1<>B1

5.5.3 - Opérateur de texte

Cet opérateur sert à relier des chaînes de caractères pour obtenir un texte global.

Opérateur Nom Exemple
& (Et) Liaison de texte Et "Sun" & "day" donne "Sunday"

5.5.4 - Opérateurs de référence

Ces opérateurs relient des plages de cellules.

Opérateur Nom Exemple
: (Deux-points) Plage A1:C108
! (Point d'exclamation) Intersection SOMME(A1:B6!B5:C12)

Les cellules B5 et B6 se trouvent ici à l'intersection ; leur somme
est à calculer.

5.5.5 - Les fonctions

Dans Calc, les fonctions sont disponibles par l'AutoPilote de fonctions qui est un outil interactif permettant la
création de formules. Avant de le lancer, il faut sélectionner dans la feuille active une cellule ou une plage de
cellules afin de définir l'emplacement d'insertion de la formule.

On accède à l'AutoPilote de fonctions par

• Menu Insertion - Fonction...

• Touches (Ctrl)(F2)

• Icône de la barre de calcul :
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• Vue de l'Autopilote de fonctions

L'AutoPilote de fonctions présente alors les différentes fonctions regroupées en catégories.

Après sélection de la fonction la boîte de dialogue s'adapte pour permettre la saisie des paramètres de la
fonction. Le mode structure est particulièrement utile pour visualiser l'enchaînement des conditions dans le
cas de fonctions imbriquées.

5.5.6 - Tableaux croisés dynamiques et Solveur

Ces deux outils permettent de fournir des outils d'analyse de données parmi les plus sophistiqués existant
dans les tableurs

Tableaux croisés dynamiques

Dans OpenOffice.org 1.0, les tableaux croisés dynamiques sont réalisés au moyen de la commande
Données> Pilote de données.

Le pilote de données permet d'analyser et d'évaluer des données qui ont déjà été saisies ; il est ainsi possible
d'établir différents rapports à partir des mêmes données, en fonction du critère mis en avant.

La fonction Pilote de données paraît plus complète que la fonction Tableaux Croisés dynamiques. En
particulier, il est possible de trier les données sur les arguments « pilotes du tableau ».

Voici l'exemple tiré de l'aide de OpenOffice.org 1.0.

« Imaginez une table d'analyse de données contenant les chiffres des ventes réalisées par votre entreprise et
classées par groupes de marchandises, filiales et années. Le pilote de données permet d'effectuer une
recherche des données intéressantes en fonction de la situation du moment.
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Cadre d'utilisation du pilote de données

Les tables créées à l'aide du pilote de données sont interactives : vous pouvez trier, réorganiser ou même
regrouper les données selon différents points de vue. Cette fonctionnalité est par ex. intéressante dans le cas
du contrôle des ventes : il peut être important de consulter les chiffres d'affaires d'une certaine période, ou
d'évaluer les chiffres des ventes en fonction de critères géographiques.

Création d'une table avec le pilote de données

1. Sélectionnez la plage de données d'une table, en-têtes de ligne et colonne inclus.

2. Activez Données - Pilote de données - Activer. Dans la boîte de dialogue Sélection de la source,
choisissez l'option Sélection active et confirmez avec OK. Dans la boîte de dialogue Pilote de
données, les en-têtes de lignes et colonnes de la table sont reprises sous forme de boutons : vous
pouvez les répartir entre les zones de mise en page "Colonne", "Ligne" et "Données" par Glisser-
Déposer.

3. Répartissez les champs dans les zones de mise en page en les faisant glisser avec la souris

Lorsque vous déposez un bouton dans la zone Données, une étiquette y est créée, portant la mention
supplémentaire de la formule appliquée pour la création des données dans la plage correspondante.

Un double-clic sur un des champs de la zone Données ouvre la boîte de dialogue Champ de données.

Celle-ci permet de choisir la fonction à utiliser pour l'affichage des données dans la plage de données. Pour
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sélectionner plusieurs fonctions, appuyez sur la touche (Ctrl) au moment du clic.

• Servez-vous de la souris si vous devez modifier l'ordre des boutons déposés dans la zone de mise en
page.

• Pour retirer un bouton de la zone de mise en page, faites-le glisser à l'aide de la souris sur son
emplacement d'origine.

• Un double-clic sur un des boutons de la zone Ligne ou Colonne ouvre la boîte de dialogue Champ
de données. Celle-ci permet de décider si et comment OpenOffice.org doit calculer et afficher les
sous-totaux.

Quittez le pilote de données avec OK. La feuille de calcul comporte maintenant un bouton Filtre (par défaut
juste en dessous de la plage sélectionnée) suivi, deux lignes plus bas, de la table générée par le pilote de
données. »

5.5.7 - Solveur

Cette fonctionnalité n'est pas disponible dans OpenOffice.org 1.0.

Il semble toutefois qu'un Solveur soit en cours de développement et qu'une version simplifiée soit
opérationnelle. Des tests sont en cours pour en vérifier le fonctionnement. Cependant, les candidats testeurs
sont attendus sur ce projet.

Si cette fonctionnalité vous intéresse voici l'adresse ou l'on peut contacter la personne qui l'a écrit :

http://www.wolfhart-bauer.de/solver/solver.zip

ainsi que l'adresse mail du développeur :

mail@wolfhart-bauer.de
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6 - L'OUTIL DE PRÉSENTATION

Cette partie détaille les fonctionnalités spécifiques aux outils de présentation de chaque suite. La
comparaison porte sur les modalités d'utilisation de ces outils et les commandes correspondantes de menu ou
de raccourci clavier. 

Le principe de fonctionnement d'un outil de présentation est de permettre la création de diapositives et d'en
assurer l'affichage soit en mode automatique soit en mode manuel. Les résultats à obtenir étant très standards,
l'aspect général des deux suites est quasiment identique. 

Les deux suites disposent donc d'outils de présentation comparables. 

6.1 - Notions d'utilisation de Impress

Pour Impress, quelle que soit l'insertion que vous faites, que ce soit une image, du texte, un dessin, du son, il
s'agit en fait d'un objet. Chacun de ces objets peut ensuite recevoir une animation : mouvement,
temporisation, coloration, sonorisation.

Vous avez accès à la barre d'outils contextuelle correspondante à l'objet appliqué : barre d'outils de traitement
de texte pour un cadre de texte, barre d'outils de dessin pour un rectangle, etc.

Lorsque vous appliquez un effet à un objet, celui-ci est directement visible ou audible par simple clic dans
une fenêtre de visualisation liée à la boite d'effet. De même, c'est dans cette boite d'effet que vous réglez
l'ordre d'apparition des objets sur la diapositive, un simple glissé/déplacé d'un objet sous un autre vous le
permet.

Voici une idée de votre espace de travail en mode dessin.

Enfin différents modes sont accessibles pour vous permettre de créer rapidement des diapositives et
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d'organiser votre diaporama. D'autres modes sont disponibles, mais ils se rapprochent de ceux que vous
connaissez déjà (comme le mode plan par exemple).

Arrière-plan

L'icône d'arrière plan vous amène au fond de la diapositive. Vous pouvez insérer ici les différents objets que
vous souhaitez voir apparaître sur les diapositives tout au long de la présentation. Ainsi vous y placerez le
logo de votre société ou encore la date ou bien le numéro de page.

Bien sûr, en utilisant un style de page pour l'arrière plan vous pourrez modifier celui-ci de façon ponctuelle
pour une seule diapositive (style de page particulier attaché à cette diapositive) ou de façon durable pour
toutes vos diapos (modification du style de page standard).

6.2 - Mode couche

Une couche fonctionne comme un transparent. Ainsi, dans ce mode, c'est comme si vous superposiez
différents transparents sur une diapositive. Sur chaque couche vous pouvez insérer différents objets avec
leurs animations. L'avantage, c'est que vous pouvez décider de faire apparaître ou non une couche placée sur
une diapositive, de même vous pouvez décider de son impression ou non, ou bien encore en bloquer l'édition
pour qu'elle ne soit jamais modifiée.

6.3 - Mode diapositive

Ce mode est réservé à l'organisation de la présentation. C'est ici que vous pourrez modifier l'ordre de vos
diapositives, en insérer venant d'une autre présentation ou encore en copier, ceci par simple glisser/déposer.

Ce mode vous permet également d'insérer une transition entre les diapositives, des effets de fondus enchaînés
ou d'apparition vers la droite ou la gauche, etc... C'est enfin ici que vous réglerez la temporisation
d'affichage des diapositives et de transition.

6.4 - Mode live

Ce mode vous permet d'ajouter la dernière touche à votre présentation. En effet, vous pouvez intervenir
directement à l'intérieur du diaporama alors qu'il est en train de défiler à l'écran via le navigateur, cela permet
entre autres de faire des réglages fins, de mieux régler une temporisation...

6.5 - Mode notes

Enfin, ce mode est réservé à la prise de note sur votre diaporama. Cela peut vous servir de base pour le
commentaire oral que vous allez faire, ou encore permettre à votre auditoire d'en garder une trace écrite
relative à chaque diapositive si vous avez décidé de l'imprimer. Il est ainsi possible d'optimiser le type
d'impression que vous désirez : uniquement des notes, réservé à une présentation papier, seulement certaines
diapositives et leurs notes...
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6.6 - Réalisation d'une présentation simple

Les deux suites proposent des modèles de diapositives et des types d'enchaînements prédéfinis. Il est donc
aisé de réaliser une présentation simple comportant une suite de diapositives qui se succèdent selon des
enchaînements standards.

Le tableau ci-après récapitule les commandes de chacune des suites nécessaires pour réaliser une
présentation simple.

MS PowerPoint 97 OpenOffice.org 1.0 Impress
Commande menu Clavier Menu Clavier

Édition Sélectionner tout
Effacer
Dupliquer
Supprimer la diapositive

Ctrl A
Suppr
Ctrl D

Édition Sélectionner tout

Dupliquer
Supprimer la page 

Ctrl A
Suppr

Maj F3

Affichage Diapositive
Plan
Trieuse de diapositives
Page commentaires

Pas de commande équivalente
Affichage Diaporama

Diapositive miniature

Affichage Mode de travail
Mode Dessin
Mode Plan
Mode Diapo
Mode Notes
Mode Prospectus

Pas de commande équivalente
Affichage Aperçu

Insertion Nouvelle diapositive
Dupliquer la diapositive

Insertion
Numéro de diapositive
Date et heure
Tabulation
Caractères spéciaux

Insertion Page
Dupliquer la page

Insertion Champs
Numéro de page
Date/Heure

Caractères spéciaux
Tab

Format Police
Puce
Alignement
Interligne
Changer la casse
Mise en page des diapo ...

Format Caractères
Numérotation/Puce
Paragraphe>Alignement
Paragraphe>Interligne
Casse/Caractères
Modifier la mise en page

Diaporama
Visionner le diaporama

Présentation à l'écran
Présentation à l'écran

6.7 - Réalisation d'une présentation personnalisée

Le présent paragraphe reprend les principales fonctionnalités permettant d'obtenir des présentations
sophistiquées soit avec des outils plus élaborés, soit à l'aide de modèles, soit au moyen d'images et de sons
incorporés.

A cet égard, il convient de remarquer que la suite MS Office est largement mieux fournie en supports tels
que fonds de pages, modèles, images,...

La création de présentation comportant du son par enregistrement n'est pas disponible dans OpenOffice.org.

Il est cependant possible d'introduire des fichiers sons pour chaque diapositive, mais pas possible par
exemple de lancer un commentaire couvrant toute la présentation.
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MS PowerPoint 97 OpenOffice.org 1.0 Impress
Fichier Enregistrer au format HTML

Présentation à emporter

Fichier Enregistrer
Page Web

Pas de commande équivalente

Pas de commande équivalente
Édition Liaisons

Objet
Pas de commande équivalente

Édition Navigateur
Édition Liens

Objet
ImageMap

Affichage Masque
Noir et Blanc

Pas de commande équivalente
Commentaires du Présentateur
Commentaires
En-tête Pied de page

Pas de commande équivalente

Affichage Couche
Qualité de l'affichage
Qualité de l'aperçu

Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Affichage  Arrière plan

Insertion Diapositive de fichier
Diapositive de Plan

Insertion Commentaire
Insertion Image

Zone de texte
Films et sons
Diagramme
Liens Hypertexte

Pas de commande équivalente
Pas de commande équivalente

Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Insertion Image
Barre d'instruments
Pas de commande équivalente
Insertion Diagramme

Hyperliens
Table
Frame

Format Remplacer les Polices
Jeu de couleurs des diapositives
Arrière Plan
Appliquer le modèle

Format Couleurs et traits

Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente

Pas de commande équivalente
Format Remplissage

Page>Arrière plan
Pas de commande équivalente
Format Ligne et
Format Position et taille
Format Cotation
Format Connecteur
Format Style

Styliste
FontWork
Effet 3D
Groupe

Outil Image Automatique
Diapo-Conférence
Aide-mémoire

Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente

Diaporama
Vérification du minutage
Enregistrer la narration
Paramètres du diaporama
Afficher sur deux écrans
Boutons d'actions
Prédéfini l'animation

Personnaliser l'animation

Aperçu de l'animation
Transition

Présentation à l'écran
Présentation chronométrée

Pas de commande équivalente
Paramètres de la présentation

Pas de commande équivalente
Pas de commande équivalente

Animation 
Effets
Animation
Effets

Pas de commande équivalente
Transition
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7 - LES FONCTIONNALITÉS SPÉCIFIQUES

Ce chapitre comporte quelques éléments descriptifs techniques de la suite OpenOffice.org. Il s'agit
simplement de quelques indications sur des points particuliers qui marquent une certaine différence avec les
outils de la société Microsoft.

7.1 - Le navigateur

Pour la création de rapports et de notes complexes OpenOffice.org dispose d'un outil très performant
dénommé le Navigateur.

Cet outil est comparable au mode lecture à l'écran ou Explorateur de documents de Word.

Il s'en distingue nettement sur deux points :

• le navigateur est disponible dans tous les outils de la suite ;

• la richesse des fonctionnalités offertes.

Sur ce dernier point, tout objet présent à l'intérieur d'un document peut servir de référence au navigateur. Il
est donc possible de naviguer dans le document à partir des titres, des tableaux, des images, des objets OLE,
etc. La liste des objets repérés se plie et se déplie selon le même mode qu'un Explorateur ainsi que le montre
l'image ci-après.

Le Navigateur peut être placé sur le bureau et déplacé comme une fenêtre. Il peut aussi être ancré à l'un
quelconque des cotés du bureau selon la méthode décrite au paragraphe 2.1.4 Les fenêtre ancrables

Voici la présentation avec le navigateur ancré à gauche du bureau

Page 71/84 Version 1.0.1 du 24/06/2003

Icône d'activation du 
navigateur



L'affichage ou la fermeture de la fenêtre ancrée s'obtient en cliquant sur la flèche d'affichage .

La fenêtre peut être rendu flottante ou ancrée en cliquant sur le bouton . La fenêtre est flottante quand elle
se superpose au document. Elle est ancrée quand le document est juxtaposé à la fenêtre et apparaît donc dans
sa totalité.

Le Navigateur se compose de trois parties :

• en partie haute, les icônes donnant accès aux fonctions

• en partie centrale, la partie navigation

• en partie basse une fenêtre d'affichage des documents ouverts

Le Navigateur est disponible avec des présentations et des fonctionnalités adaptées pour
certaines fonctionnalités avancées de la suite OpenOffice.org telles les documents maître ou
les formulaires.

Ces dispositifs avancés ne sont pas décrits ici. L'aide de OpenOffice.org fournit des
informations complètes sur ces sujets.

7.1.1 - Naviguer dans le document

Le Navigateur permet donc de se déplacer à l'intérieur d'un document. Chaque élément (titre, tableaux,
feuille de calcul, plage de données) constituant votre document est référencé dans la fenêtre principale du
navigateur. Un clic sur l'un d'entre eux positionne le curseur directement à son emplacement dans le
document.
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Pour des documents très complexes, vous pouvez souhaiter n'afficher que la rubrique dans laquelle vous
voulez naviguer : par chapitre, par tableaux, par nom de plages... Pour cela, sélectionnez la rubrique
concernée et cliquez sur l'icône Basculez l'affichage du contenu. Dans la fenêtre principale, ne s'afficheront
que les éléments de cette rubrique.

Vous pouvez encore affiner votre navigation en indiquant les niveaux de titres à afficher. Cliquez sur l'icône
correspondante dans la barre d'outils en haut de votre Navigateur et choisissez la profondeur de niveau à
afficher en cliquant sur le numéro correspondant.

7.1.2 - Atteindre d'autres documents

La liste déroulante située en bas du navigateur indique tous les documents OpenOffice.org ouverts et qui
figurent dans la barre d'état de Windows. Pour atteindre facilement un point d'un de ces autres documents,
sélectionnez son nom dans la liste déroulante. Son contenu (chapitres, tableaux...) s'affichera dans la fenêtre
principale du Navigateur, sans pour autant qu'il s'ouvre à l'écran. Un double clic sur l'un des éléments dans
cette fenêtre vous permettra de l'atteindre directement dans le document qui s'affichera alors sur votre écran.

7.1.3 - Organiser votre document

A l'aide du Navigateur vous avez également accès à des outils qui vous permettent d'organiser votre
document, rappelant les fonctionnalités du mode plan.

Il vous est ainsi possible de déplacer un chapitre ou sous chapitre. Sélectionnez la partie à déplacer dans la
fenêtre principale du Navigateur et cliquez ensuite sur l'icône chapitre vers le haut ou chapitre vers le bas.
Autant de fois que nécessaire pour le déplacer à l'endroit voulu.

De la même manière vous pouvez hausser ou baisser les chapitres d'un ou plusieurs niveaux. Là encore, la
fonction est accessible dans la barre d'outils sise en haut du Navigateur.

Certaines rubriques ont des fonctions particulières associées, notamment en ce qui concerne les tableaux.

Sélectionnez le nom d’un de vos tableaux dans la fenêtre principale du Navigateur. Faites un clic droit sur
cette sélection pour en afficher le menu contextuel.

Tout en bas de ce menu, vous verrez une rubrique Tableau. A cet endroit vous aurez la possibilité d’éditer le
formatage du tableau (sauf s’il est protégé), de le déprotéger (sauf s’il ne l’est pas), de le supprimer ou de le
renommer.

Repères de texte, images, objets OLE, index, etc comportent un menu contextuel similaire.

La commande Supprimer l’index, supprimera l’index, mais laissera le contenu sous forme de texte, par
exemple votre table des matières automatique deviendra un simple texte. De même que la commande En
lecture seule de ce même menu contextuel protégera l’index contre toutes modifications.

Si des éléments sont masqués dans votre document (section, index, tableaux...), leur nom apparaîtra en grisé
dans le Navigateur

Le Navigateur comporte également trois fonctions très intéressantes pour la mise en oeuvre de votre
document : insérer comme lien, insérer comme une copie, insérer comme hyperlien

• insérer comme lien : dans le navigateur, cliquez sur l'élément (un sous-chapitre par exemple) que
vous souhaitez insérer dans votre document, faites un clic droit pour afficher le menu contextuel.
Choisissez le Mode glisser, puis insérer comme lien. Cliquez sur le sous-chapitre sélectionné dans
le Navigateur et sans relâcher le bouton de la souris, glissez le dans votre document à l'endroit
souhaité. Relâchez votre doigt, vous constatez qu'une section contenant l'ensemble du sous-
chapitre s'est inséré dans votre document. Cette section est liée au sous-chapitre que vous venez de
copier. Ce qui signifie que si vous modifiez le sous-chapitre (source) dans votre document, le
contenu de cette section contenant la copie sera également modifié.

• Insérer comme une copie : suivant l'exemple du sous-chapitre utilisé ci-dessus, dans le menu
contextuel, cette fois-ci choisissez insérer comme une copie. De la même manière faites glisser le
sous-chapitre choisi dans votre texte, une section se crée contenant également le contenu du sous
chapitre, mais cette fois, aucun lien avec la source, si vous la modifiez, le contenu de la section n'en
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sera pas affecté. 

• Insérer comme hyperlien : à partir du même sous-chapitre, faites un clic droit dans le menu
contextuel et choisissez insérer comme hyperlien. Glissez le sous chapitre choisi dans votre
document : un hyperlien renvoyant au sous chapitre choisi s'insère. Cette méthode est très pratique
pour faire des tables des matières dans les documents HTML ou des renvois entre chapitres. 

Vous pouvez également modifier le Mode Glisser à partir de la barre d’outils du Navigateur en cliquant un
peu longuement sur l’icône et en sélectionnant le mode voulu.

Ce mode fonctionne également entre documents. Comme nous l’avons vu plus haut, il vous est possible
d’afficher le contenu d’un document non actif à l’écran (ouvert dans la barre d’état de Windows) dans la
fenêtre principale du Navigateur. Vous pouvez ainsi sélectionner chapitre, feuille de calcul, ou tout autre
élément dans ce document et l’insérer en Mode Glisser dans le document sur lequel vous êtes entrain de
travailler. Suivant l’élément dont il s’agit, tous les modes ne sont pas disponibles.

Sous Calc, le Navigateur vous permet de mettre en oeuvre vos Scénarios, de les démarrer, les
renommer...

Sous Impress, vous avez la possibilité de l'afficher lors de la présentation, vous permettant
ainsi d'intervenir en modification sur les objets.

7.2 - Le styliste

Dans le même esprit que le Navigateur OpenOffice.org dispose d'un outil dénommé Styliste pour l'aide à la
rédaction, à la réalisation et à la mise en forme de documents. Cet outil permet d'afficher tous les styles et de
les apposer très rapidement et simplement à l'objet désigné.

L'approche suivie par OpenOffice.org est de recommander l'utilisation de style pour la confection des
documents (texte classeur, présentation, etc.). Pour certaines fonctionnalités, cette approche est même
obligatoire. Ainsi une mise en page spécifique dans le tableur ne sera conservée et donc retrouvée à
l'ouverture suivante que si un style de page a été défini.

De même, il est possible de définir des styles pour chacun des objets manipulés dans la suite.

Le styliste est donc disponible dans toutes les composantes de la suite.

On voit ci-après un écran présentant le Styliste dans le cadre du traitement de texte.
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Bien entendu les commandes de la suite pour la création et la modification des styles sont disponibles dans
les menus et commandes ainsi que dans les menus contextuels.

Le styliste dispose d'une fonction permettant de recopier le style actif. Il faut ouvrir le Styliste et sélectionner
le mode Remplir Tout ou verseuse. On recopie le style actif en positionnant le curseur sur le paragraphe et en
cliquant sur le bouton de la souris. Pour copier un style sur des caractères, il faut auparavant les sélectionner. 

Le Styliste est l'outil de OpenOffice.org qui facilite et organise la gestion des styles et leur mise en
application. 

La fenêtre du Styliste est affichée par la commande Format>Styliste, l'icône  ou, la touche F11 

Cette fenêtre peut être utilisée comme une palette que l'on peut déplacer sur l'écran avec la souris. Elle peut
être réduite ou fermée avec les outils classiques.

Le Styliste peut aussi être ancré sur l'une quelconque des bordures de l'espace de travail

Vous pouvez à partir de ce Styliste déterminer à l'avance tous les styles de votre document. Un clic droit sur
le style choisit vous permet de le modifier selon votre choix. Une fois le style modifié, un double clic sur
celui-ci et il est alors appliqué à l'endroit souhaité dans le document.

La liste déroulante en bas du Styliste, vous laisse le choix d'affichage des styles voulus : uniquement ceux
que vous avez personnalisés, uniquement ceux déjà utilisés dans le document... 

7.3 - La gestion des bases de données

7.3.1 - Les sources de données

OpenOffice.org n'a pas de base de données intégrée comme la suite MS Office.

En compensation de cette faiblesse, la suite OpenOffice.org est largement ouverte vers les sources de
données externes y compris les bases de données relationnelles.

Voici la liste de type de base de données qui peuvent être connectées dans OpenOffice.org

OpenOffice.org 1.0 
texte

classeur 

dBase

ADO

ODBC

JDBC

Carnet d'adresses
(Windows, MS Outlook, Mozilla/Netscape ou LDAP) 

Pour pouvoir utiliser une source de données, il faut d'abord l'assigner (faire connaître) par OpenOffice.org.

Pour cela, il faut afficher la boîte de dialogue « Gestion des sources de données » par la commande
Outils>Source de données :
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A partir de l'onglet « Général », à gauche, s'affichent les tables déjà créées et repérées par le gestionnaire de
base de données. 

Pour assigner par le panneau de contrôle des données, il faut procéder aux opérations suivantes :

• Cliquer en haut et à gauche sur « Nouvelle source de données ».

• Dans la partie de droite, donner lui un nom.

• Sous Connexion, choisir le Type de source de données. 

Cliquer sur le bouton gris à droite (marqué avec...) pour sélectionner le fichier de données dans le répertoire
adéquat. Cliquer sur le bouton « Appliquer ». Cliquer sur Ok pour connecter une source de données, il faut
tout d'abord

7.3.2 - Le panneau de contrôle de source de données

Le moyen d'accès aux données est le panneau de contrôle des données. 

Le panneau de contrôle des données est activé soit par le menu Affichage>Source de données soit par la
touche F4.

Le panneau de contrôle des données est une fenêtre ancrable qui peut être manipulée et placée sur le bureau
selon les mêmes facilités que pour les autres outils (Navigateur, Styliste, Gallery).

Le panneau de contrôle des données se comporte comme un véritable Explorer. Il permet de changer de base
de données et de visualiser le contenu de chacun des enregistrements de la base sélectionnée. Il est possible
par cette interface de réaliser des tris, des sélections, d'appliquer des filtres. OpenOffice.org dispose donc
d'un outil de gestion de données performant et intégré.

Il est également possible par cet outil de faire des requêtes SQL directement à partir des composantes
principales de la suite.

C'est l'outil de choix pour la réalisation de publipostage, étiquettes (voir paragraphes 4.7).

Un simple glisser-déposer des noms de champs de la source de données vers le document de publipostage
permet de mettre en page le document. 

Cet outil disponible dans le traitement de texte et le classeur est l'un des plus performants de OpenOffice.org.
Voici une copie d'écran du panneau de contrôle des données
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8 - LA COMPATIBILITÉ DES FICHIERS 

La migration d'une suite bureautique vers une autre suite impose de fait une période de cohabitation des deux
suites chez les utilisateurs. Pendant cette période de cohabitation et ultérieurement vers des services externes
équipés d'une suite différente va se poser inévitablement le problème de la compatibilité des fichiers.

Il ne faut pas se leurrer, la compatibilité totale entre les fichiers produits par chacune des suites n'existe pas
d'autant plus que les formats de fichiers de certaines suites sont propriétaires et non divulgués et que ces
formats varient selon les versions.

Une compatibilité partielle peut être obtenue de manière à minimiser les problèmes rencontrés dans les
échanges de fichiers produits par les deux suites.

En tout état de cause, les difficultés de passage d'une suite à l'autre seront d'autant plus grandes que l'on
utilisera les fonctions avancées de chacune des suites.

Enfin, il convient de remarquer que certains documents types ou modèles peuvent avoir été créés dans des
versions anciennes de la suite MS Office. Avec l'évolution des formats successifs de la suite MS Office ces
documents ont subi des conversions qui héritent des formats antérieurs. Certaines des spécificités anciennes
sont présentent dans le fichier utilisé sans que l'utilisateur en soit averti. La conversion de tels documents
peut réserver de belles surprises

Les paragraphes ci-après essaient de récapituler les conseils pour obtenir une meilleure compatibilité.

8.1 - Les formats d'écriture dans OpenOffice.org

La suite OpenOffice.org peut produire des fichiers dans les formats d'autres suites et en particulier dans les
formats Microsoft Office.

Il ne faut cependant pas perdre de vue que ces formats externes ne sont pas les formats natifs de
OpenOffice.org. Utiliser les formats externes revient donc à exécuter une conversion de format à chaque fois
que l'on enregistre le document.

Il n'est donc pas recommandé d'utiliser les formats externes comme formats de travail.

La règle à suivre est que tout document créé avec OpenOffice.org doit l'être dans le format natif de la suite : 

• Traitement de texte : sxw

• Tableur : sxc

• Présentation : sxi

L'utilisateur doit enregistrer dans ces formats natifs tout au long de son travail. 

Si le fichier produit doit être transmis à un service externe n'utilisant pas OpenOffice.org, ce n'est qu'en
dernier lieu, juste avant transmission, que l'on enregistrera le document au format externe.

8.2 - Les méthodes de travail inter groupes

Il est de plus en plus fréquent que des documents (le plus souvent notes ou rapports, rarement des classeurs)
soient produits par plusieurs services ; le service compétent se chargeant d'élaborer la note sur le fond et
demandant des avis ou compléments aux autres services.

Dans ces cas, il est évident que les documents vont faire des allers et retours entre les différentes suites.
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La recommandation principale est donc que les services doivent s'accorder pour établir tout d'abord le fond
du document et son organisation générale sans se préoccuper la forme. Cette recommandation est également
valable si le service initiateur de la note n'utilise pas OpenOffice.org 

En effet, c'est principalement dans la mise en forme du document que se pose les problèmes de compatibilité.

La mise en page générale (marges, en-tête et pied de page, numérotation des pages, positionnement des
logos, sommaire éventuel) doit être de préférence effectuée lorsque tous les services se seront accordés sur
le contenu de la note. Cette tâche incombera au service initiateur du document.

Il convient de remarquer que les outils de plan sont d'une très bonne compatibilité entre suites et que dans ces
conditions si l'on évacue le problème de la mise en forme et de la présentation finale le travail inter service
peut parfaitement s'organiser avec des suites différentes.

Une autre solution est d'implanter la suite OpenOffice.org comme suite complémentaire dans les services
externes. Cette implantation ne peut poser de difficultés financières puisque la suite est gratuite.

De plus, son utilisation respecte les mêmes principes de fonctionnement que la suite Microsoft. Un utilisateur
ne devrait donc pas ressentir de gêne importante à l'utilisation de OpenOffice.org pour valider, corriger ou
apporter des compléments à un document principalement élaboré par un autre service;

8.3 - Les principales difficultés de conversion

A l'ouverture dans OpenOffice.org d'un fichier créé dans la suite MS Office, on constate, à l'affichage sur
l'écran ou à l'impression, que la mise en page des documents est généralement bien conservée.

Les difficultés commencent quand il faut enregistrer ce document d'origine MS Office, soit dans un format
natif de OpenOffice.org, soit dans un format propriétaire de MS Office. C'est en effet à ce moment là que
l'on constate des pertes de format.

Il faut bien insister sur le fait que les seuls problèmes rencontrés portent sur la mise en forme des documents,
en aucun cas sur leur contenu.

A cet égard, il faut distinguer les conséquences liées à l'enregistrement du fichier de celles liées à sa
fermeture.

A chaque opération d'enregistrement ou de fermeture dans un format qui n'est pas celui du fichier d'origine
ou qui n'est pas celui natif de OpenOffice.org, le logiciel annonce que des pertes de format sont possibles.

En réalité, les pertes de format ont lieu lors de la fermeture du fichier. OpenOffice.org convertit
effectivement le fichier dans sa nouvelle structure lors de l'opération de fermeture.

L'utilisateur non averti pourra ainsi croire que les modifications qu'il effectue seront définitives car il les a
enregistrées et continuera son travail en toute bonne conscience. En réalité, certaines de ces modifications de
mise en page seront perdues lors de la fermeture du fichier. Le résultat obtenu dans la conversion pourra
donc être différent de celui attendu.

Ces problèmes sont toutefois bien cernés et recensés ci dessous.

Les macros

C'est la principale difficulté de conversion entre les deux suites. Les langages utilisés ne sont pas compatibles
et les macros utilisées dans un fichier MS Office ne sont pas utilisables sans réécriture importante dans
OpenOffice.org.

Cette difficulté est particulièrement sensible pour les fichiers Excel dans lesquels il est fréquent d'inclure des
macros.

Un projet vient d'être initié pour créer un convertisseur de macros. Cependant, ce convertisseur ne sera pas
opérationnel dans l'immédiat.
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Les styles de caractères, paragraphes et pages

La principale difficulté de la conversion vient du fait que dans la majeure partie des cas les fichiers créés
avec la suite MS Office n'utilisent pas les fonctions de style.

La suite OpenOffice.org privilégie l'utilisation des styles.

De ce fait, lors de la conversion de fichier toutes les surcharges de mise en forme effectuées avec des
commandes Format Caractères ou Paragraphes, etc sont transformées en styles de conversion. On voit donc
apparaître dans la liste des styles nommés « WWxxxx » qui sont autant de styles de paragraphes, de
caractères, de numérotation, attachés à une mise en forme particulière.

Le problème est particulièrement sensible pour la mise en page des documents ou OpenOffice.org utilise un
style de page alors que MS Office attache la mise en page à la section.

La solution réside donc dans une utilisation dans les deux suites des styles. Les résultats de conversion les
meilleurs sont obtenus dans cette situation.

Les marges

La conversion d'un fichier MS Office dans un format OpenOffice.org ne conserve pas les marges d'origine.
en particulier, celle du haut de page.

Ainsi qu'il a été écrit au paragraphe précédent, la conversion crée des styles de page, chaque fois que la mise
en page change (en tête, pied de page, marges, etc.). Il en résulte que les pages du document converti sont
affectées d'un style de page « Conversion » et que ces styles peuvent être très nombreux.

Pour éliminer, ces problèmes de marges, il faut donc 

• soit agir sur chacun des styles de conversion pour restaurer les marges ;

• soit supprimer ces styles et appliquer les styles de page natifs ou créés sur le document converti. 

Les en-têtes et pieds de page

Dans OpenOffice.org les en-têtes et pieds de page sont attachés au style de page. Cette méthode permet sans
conteste de gérer les mises en page de manière beaucoup plus fine et naturelle.

Elle a cependant des effets redoutables dans les cas où il est nécessaire de modifier un fichier entre plusieurs
services dotés chacun d'une suite différente. Dans ce cas, il est nécessaire de procéder à des conversions
multiples et on constate que 2 ou 3 conversions d'un format dans l'autre suffisent à détruire la présentation
des en-têtes et des pieds de page.

Si l'on se trouve dans cette situation, la seule solution est de réserver la création des en-têtes et des pieds de
page au service qui finalise le document et d'éviter de mettre des en-têtes ou pieds de page dès le début de la
création du document.

Les écarts avant et après dans les tableaux 

OpenOffice.org considère que les écarts avant et après un paragraphe ne sont pas pris en compte pour régler
la distance entre le texte et la bordure dans les cellules d'un tableau. Il faut pour cela utiliser un paramètre
spécial «  Écart avec le contenu ».

Cette solution permet d'obtenir une présentation tout à fait paramétrable des tableaux.

En revanche, dans la conversion d'un fichier de MS Word vers OpenOffice.org Writer ou l'inverse, les
paramètres utilisés par chacune des suites ne sont pas repris par l'autre.

Il n'y a pas d'autre solution que de reprendre la mise en forme dans l'une ou l'autre suite sur le document
final.
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Le titre du document

Lors de la conversion dans OpenOffice.org, le titre du document est initialisé par les premiers mots contenus
dans le document source.

De ce fait, à l'affichage du document, OpenOffice.org, indique dans la barre de titre, un titre sans
signification particulière au lieu du nom du fichier ou de son titre réel.

Pour corriger ce défaut, après conversion, il faut modifier les propriétés du document par la commande
Fichier>Propriétés onglet Description et :

• soit supprimer le titre pour obtenir l'affichage du nom du fichier ;

• soit modifier le titre qui remplacera le nom de fichier dans la barre de titre ;

Après cette opération, fermer le fichier. A la réouverture, la modification sera opérationnelle.

Les fonctions avancées de mise en  forme

Il est évident que plus les documents à convertir utiliseront des fonctions avancées de mise en forme plus
l'utilisateur rencontrera de difficultés lors de la conversion.

On peut citer à titre d'exemple les fonctions suivantes :

• les insertions de légendes sous forme de bulles de texte

• certaines modifications de mise en forme natives dans les graphiques (légendes en particulier)

• assez généralement certaines mises en forme provenant des outils de dessin ;

La liste précédente n'est pas limitative. Il appartient à chacun de se forger sa propre expérience et d'éviter de
recourir autant que faire se peut à ces outils dans le cas d'un travail collaboratif avec des services ne
disposant pas de suites identiques.

Dans ces cas d'utilisation de fonctions de mise en forme avancées somme toute assez peu nombreux, la
solution la plus simple est d'équiper les services qui collaborent de la même suite.

Dans cette perspective, le principe d'économie conduira à diffuser la suite gratuite OpenOffice.org.

8.4 - La reprise de documents dans OpenOffice.org

Dans ce paragraphe, il s'agit de donner quelques consignes qui peuvent être appliquées lorsqu'il s'agit
d'utiliser OpenOffice.org pour lire ou modifier ou utiliser des fichiers créés dans la suite MS Office

8.4.1 - Document en communication

Dans ce cas, il s'agit simplement de lire un document transmis dans un format de la suite MS Office, la
simple ouverture du document suffit pour en prendre connaissance.

Dans ce cas la mise en forme du document source est généralement très bien respectée. De même
l'impression ne pose pas de problème majeur.

On peut donc laisser le document dans son format propriétaire d'origine sans faire réellement de conversion. 

A la fermeture dans OpenOffice.org, il suffit simplement de ne pas enregistrer les modifications si une telle
demande est formulée par le logiciel.

8.4.2 - Document à modifier

Il s'agit dans ce cas de travail collaboratif entre plusieurs services dotés de suites différentes. 
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La difficulté est d'évaluer a priori le nombre de conversions qui vont être effectuées dans les échanges entre
services.

Si ces conversions risquent d'être peu nombreuses (un aller et retour entre service) on peut conserver le
format Ms Office qui est compris par les deux suites. Les perturbations générées par les modifications
apportées dans chacune des suites seront peu génératrices de problèmes. Ces perturbations seront d'autant
moins nombreuses que la mise en forme sera simplifiée.

Sinon, il faut se replier sur les méthodes de travail inter-groupe, donc d'éviter d'utiliser dans les étapes de
création du document les fonctions de mise en page qui posent problèmes et de réserver la mise en forme
définitive à l'étape finale.

8.4.3 - Document à utiliser comme modèle ou à réutiliser souvent

Dans ce cas il s'agit de reprendre des modèles ou documents types provenant de MS Office dans un format
natif de OpenOffice.org. Il s'agit de créer des documents à usage régulier et partagés dans un même service et
qui seront exclusivement utilisés dans la suite OpenOffice.org.

Aucun résultat satisfaisant à moyen et à long terme ne sera obtenu par une conversion du fichier source. En
effet, malgré toutes les opérations de nettoyage des formats de conversion qui seront menées, il restera
toujours des séquelles de l'origine externe à la suite OpenOffice.org du document. Un jour ou l'autre des
problèmes de mise en forme inopérante ou mal opérante apparaîtront sans explication ou correction
possibles.

De ce fait, il est recommandé pour des documents types ou modèles de les récréer nativement dans le format
OpenOffice.org.

A cet égard, pour créer un nouveau document type ou modèle, il ne faut pas utiliser les fonctions de
Copier/Coller ou Glisser/Déposer entre les deux suites. 

En effet par ces fonctions, on importe dans OpenOffice.org les attributs de caractères ou de mise en forme
liés à la partie sélectionnée et issus de MS Office. Le résultat serait donc comparable à une conversion et les
fichiers obtenus ne seraient pas nativement au format OpenOffice.org.

8.4.4 - Création de document pour Ms Office dans OpenOffice.org.

On se place dans l'hypothèse d'un service équipé de OpenOffice.org et devant produire un document à
destination d'un autre service doté de MS Office.

Il est absolument déconseillé de créer entièrement un document dans OpenOffice.org au format MS Office.
Les multiples enregistrements, ouverture et fermeture du document avant sa finalisation conduiraient à des
résultats proches de conversions successives.

Le document doit donc être créé au format natif de OpenOffice.org. Toutes les modifications effectuées tant
que le document n'est pas finalisé doivent être enregistrées dans ce format natif.

Ce n'est qu'au moment de la transmission vers le service externe utilisateur de MS Office que
l'enregistrement dans un format propriétaire doit être effectué.

De cette manière le fichier ouvert par le service externe comportera le minimum de problème lors de
l'ouverture et l'utilisation.
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Appendix 
Public Documentation License Notice 

The contents of this Documentation are subject to the Public Documentation License Version 1.0 (the
"License"); you may only use this Documentation if you comply with the terms of this License. A copy of
the License is available at http://www.openoffice.org/licenses/PDL.html. 
The Original Documentation is Guide comparatif sur la suite bureautique OpenOffice.org. The Initial Writer
of the Original Documentation is Christian Hardy (C) 2003. All Rights Reserved.
 (Initial Writer contact(s): christian.hardy@dp.finances.gouv.fr, christian.hardy@free.fr).
Contributor(s): Sophie Gautier -_____________________________________. 
Portions created by Sophie Gautier are Copyright (C) 2003. All Rights Reserved. (Contributor contact(s):
sgauti@cenatrin.bf).
Patrick Guimberteau-_____________________________________. 
Portions created by Patrick Guimberteau are Copyright (C) 2003. All Rights Reserved. (Contributor
contact(s): pguimber@club-internet.fr).
NOTE: The text of this Appendix may differ slightly from the text of the notices in the files of the Original
Documentation. You should use the text of this Appendix rather than the text found in the Original
Documentation for Your Modifications.
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